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Introduction 

HP Power Manager enables you to monitor, manage, and control power 
environments through comprehensive control of individual HP UPSs. A familiar 
browser interface provides secure access to Management Servers anywhere on 
the network. You can control power failure settings and define UPS load 
segments to allow for maximum uptime of critical servers. 

For a detailed list of supported UPSs, refer to the Supported Hardware matrix on 
the HP Power Manager Product Overview page on the HP website 
(http://www.hp.com/products/ups). 

You can configure HP Power Manager to send alert traps to HP Systems Insight 
Manager and other SNMP management programs. The software can also run as a 
stand-alone power management system. This flexibility enables you to monitor, 
manage, and communicate with a UPS through a network port, USB port, or 
serial port with a single serial card (RS-232) or multiserver serial card (Six Port 
Card) installed. To facilitate day-to-day maintenance tasks, the software provides 
detailed system logs and system diagnostics, including UPS battery checks. 

Use HP Power Manager to: 

• Customize alerts 

– Send email notification messages. 

– Send broadcast notification messages. 

– Send SNMP traps. 

– Issue computer commands at power failure. 

http://www.hp.com/products/ups
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• Monitor, manager, and control UPSs 

– Manage a graceful shutdown of attached equipment during utility power 
failure. 

– Manage independent UPS load segments to provide separate power 
control of connected equipment. 

– Prioritize the timing of equipment shutdown and reboot connected 
equipment by load segment. 

– Delay restart by load segment after a power outage to sequence the 
startup of system components. 

– Shut down and reboot any UPS and attached equipment, based on a user-
specified schedule 

– Display text logs and graphical logs for analysis. 

– Monitor the status of UPSs and perform diagnostics. 

– Communicate with a UPS through a network port, USB port, or serial 
port with a single serial card (RS-232) or multiserver serial card (Six Port 
Card) installed. 

 

Overview 

HPPM is a Web-based application that enables administrators to manage an HP 
UPS from a browser-based management console. Administrators can monitor, 
manage, and control a single UPS locally and remotely. 

During a utility power failure, the UPS switches to battery mode. An email alert 
can be issued to the system administrator, and a prioritized system shutdown 
begins based on user-defined settings for that specific UPS. After power is 
restored, the software can facilitate a prioritized power-up for connected 
equipment. 

The UPS can be configured to extend runtimes for critical devices during utility 
power failures. For most UPSs, the receptacles on the rear panel can be divided 
into two or more groups, called load segments, which can be controlled 
independently. By shutting down a load segment that is connected to less critical 
equipment, the runtime for more critical equipment is extended, providing 
additional protection. 
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Architecture 

The architecture consists of two major components: 

• Management Server 

• Remote Agent 

 
          

Item Description 

1 HPPM Management Server 
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Item Description 

2 A UPS that is serial port, network port, or USB port attached to and 
managed by the Management Server 

3 Remote Agent server 

4 Intranet 

5 A remote workstation browsing into the Management Server over the 
network 

6 HP Systems Insight Manager receiving alert traps from HPPM 
(optional) 

 
 

Management Server 

One Management Server is needed for each UPS that is monitored, managed, and 
controlled by HPPM. The server can be connected to the UPS through a serial 
port, USB port, or network port. Specific features of the Management Server 
include: 

• Controlling security and authentication, such as: 

– Supporting multiple users and associating each login with specific device 
access (access categories are regular user and administrator) 

– Providing the option of SSL security 

• Performing specified actions when alarms are set or cleared. The following 
unattended actions are supported: 

– Sending email notifications, broadcast messages, and SNMP traps 

– Executing system batch jobs during shutdown (on the Management 
Server or Remote Agent) 

– Performing operating system shutdown by notifying the Remote Agents 
when to shut down 

– Shutting down and restarting by load segment, if applicable 

– Performing a UPS shutdown 

• Performing a graceful, remote shutdown of the local operating system after a 
specified delay 



 Overview 15 
 

 

• Maintaining event logs, which include the following types: 

– UPS event log, which contains UPS-related events, such as the UPS going 
on battery 

– Application event log, which contains application-related events, such as 
failed logins or settings changes 

• Logging data variables. The following data values are logged: 

NOTE:  Depending on the specific UPS model, some variables might 
not be supported. The following list is only an example. 

– Input voltage 

– Input current 

– Input frequency 

– Output voltage 

– Output current 

– Output source 

– Output load 

– Output power 

– UPS temperature 

– Runtime remaining 

– Battery status 

– Battery voltage 

– Battery capacity 

– Self test summary 

• Providing content for the user interface using an embedded Web server (The 
user interface is accessed using a supported Web browser. For more 
information on supported browsers, refer to the section, "Browser 
Requirements (on page 28).") 

IMPORTANT:  Power protection for the Management Server is 
essential. The Management Server is the central point of control of the 
power management environment. If the Management Server goes 
down, the ability to gracefully shut down attached servers is lost. 
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NOTE:  For the latest supported operating systems, refer to the HP 
Power Manager Product Overview page 
(http://www.hp.com/products/ups) on the HP website.   

 

Remote Agent 

The Management Server provides both status and shutdown information to the 
Remote Agent. The Remote Agent runs on a machine and allows the software to 
gracefully shut down the operating system of that server and run a script during 
power failure. Install the Remote Agent on any machine that is powered by the 
UPS and any machine that the software uses to initiate a command. However, it 
is not necessary to install the Remote Agent on the machine running the 
Management Server component. 

NOTE:  For the latest supported operating systems, refer to the HP 
Power Manager Product Overview page 
(http://www.hp.com/products/ups) on the HP website.   

 

Supported Hardware Configurations 

HP Power Manager requires that the Management Server and the computers 
running the Remote Agents are connected to the network. UPSs can be attached 
in any of the following configurations: 

• Configuration A (on page 17)—A Management Server is serially attached to 
one UPS. 

• Configuration B (on page 17)—Several Management Servers are serially 
attached to a Six Port Card on a single UPS. 

• Configuration C (on page 19)—One Management Server is serially attached 
to a UPS and communicates to several Remote Agents over the network. 

• Configuration D (on page 20)—A Management Server is attached to one 
UPS through the USB port. 

• Configuration E (on page 21)—A Management Server communicates with 
one UPS over the network. 

 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
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Configuration A 

This figure illustrates a UPS serially attached to a Management Server that is 
plugged into a load segment of the UPS. The Management Server is connected 
directly to the network. A remote workstation can browse into the Management 
Server over the network. 

 
          

Item Description 

1 Remote workstation browsing into the Management Server over the 
network 

2 HPPM Management Server 

3 UPS 

4 Network 

 
 

Configuration B 

In this figure, each server is a Management Server and is serially attached to the 
UPS through a Six Port Card. The Six Port Card makes each server operate as if 
it is the only Management Server attached to the UPS. The Six Port Card 
supports up to three attached servers, and these servers do not communicate with 
each other. 
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NOTE:  Attached Remote Agents are not tested or supported in this 
configuration. 

 
          

Item Description 

1 Remote workstation browsing into the Management Server over the 
network 

2 UPS with Six Port Card installed 

3 HPPM Management Servers 

4 Network 
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Configuration C 

In this figure, only one server is a Management Server and is serially attached to 
the UPS. This Management Server communicates to the Remote Agent servers 
over the network to begin a graceful shutdown in the event of a power failure or 
other configured shutdown events. 

NOTE:  Up to 15 Remote Agent servers can be managed by one 
Management Server. 

 
          

Item Description 

1 Remote workstation browsing into the Management Server over the 
network 

2 UPS 

3 Remote Agent servers 
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Item Description 

4 HPPM Management Server 

5 Network 

 
 

Configuration D 

This figure illustrates a UPS that is connected to the Management Server through 
a USB port. The Management Server is plugged into a load segment of the UPS 
and connected directly to the network. A remote workstation can browse into the 
Management Server over the network. 

 
          

Item Description 

1 Remote workstation browsing into the Management Server over the 
network 

2 HPPM Management Server 

3 UPS 

4 Network 
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Configuration E 

In this figure, only one server is a Management Server and it communicates to 
the UPS over the network. This Management Server communicates to the 
Remote Agent servers over the network to begin a graceful shutdown in the event 
of a power failure or other configured shutdown events. 

NOTE:  Up to 15 Remote Agent servers can be managed by one 
Management Server. 

 
          

Item Description 

1 Remote workstation browsing into the Management Server over the 
network 

2 UPS 

3 Remote Agent servers 
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Item Description 

4 HPPM Management Server 

5 Network 

 
 

Process Overview 

To get HP Power Manager up and running in your environment: 

1. Visit the HP website (http://www.hp.com/products/ups) to download the 
latest version of HP Power Manager. 

2. Connect all equipment powered by the UPS to the receptacles on the UPS 
rear panel. If the UPS has multiple load segments, note which load segment 
powers each device.  

NOTE:  By default, HP Power Manager associates the Management 
Server with load segment 1. If you connect the Management Server to a 
different load segment, you must change the default association when 
configuring HP Power Manager. 

3. Power up the UPS and all attached equipment. 

4. Be sure that the serial, USB, or network cable connecting the UPS to the 
Management Server is properly installed. 

5. Install the Management Server software according to the instructions for 
your operating system. There must be one Management Server for each UPS. 

6. Install the Remote Agent software according to the instructions for your 
operating system. 

7. Browse in to the Management Server. 

8. Manage the Remote Agents. 

9. Configure the power fail settings. 

10. Configure and customize optional settings: 

– Schedule shutdowns. 

– Set up additional user accounts. 

– Set up event notifications. 

– Set up additional shutdown events. 

http://www.hp.com/products/ups
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– Integrate HP Power Manager with HP Systems Insight Manager. 

– Set up shutdown scripts (SDScripts). 
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Installation 
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System Requirements 
NOTE:  For the latest system requirements, refer to the Supported 
Hardware matrix on the HP Power Manager Product Overview page 
(http://www.hp.com/products/ups) on the HP website.   

NOTE:  The Management Server and Remote Agent for HP Power 
Manager 4.0 are not backward compatible with earlier versions of HP 
Power Manager. 

The following table lists the Management Server minimum hardware and 
software requirements. 

http://www.hp.com/products/ups
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Hardware and Software Suggested Minimum Requirements HPPM Version 

Hardware 500-MHz processor  

Disk space 25 MB free disk space  

System memory 128 MB of RAM  

Operating System (32-bit) Microsoft® Windows® XP Professional with 
Service Pack 2 

4.0 

 Microsoft® Small Business Server 2000 with 
Service Pack 4 

4.0 

 Microsoft® Windows® 2000 Server and Advanced 
Server with Service Pack 4 

4.0 

 Microsoft® Windows® Server 2003 Standard 
Edition x86 with Service Pack 1 

4.0 

 Microsoft® Windows® Server 2003 Enterprise 
Edition x86 with Service Pack 1 

4.0 

 Microsoft® Windows® Server 2003 SBS, Standard 
and Premium x86 with Service Pack 1 

4.0 

 Red Hat Linux 7.3 Professional with Errata Kernel 
2.4.20-28 

4.0 

 Red Hat Linux 8.0 Professional with Errata Kernel 
2.4.20-28 

4.0 

 Red Hat Enterprise Linux 2.1 for x86 with Update 5 4.0 

 Red Hat Enterprise AS/ES Linux 3 for x86 with 
Update 4 

4.0 

 SUSE Linux Enterprise Server 9 for x86 with 
Errata Kernel 2.6.5-7.111 

4.0 

Operating System (64-bit) Microsoft® Windows® Server 2003 for AMD64 and 
Intel EM64T 

4.0 

 Microsoft® Windows® Server 2003 Enterprise 
Edition For Integrity with Service Pack 1 

4.0 

 Red Hat Enterprise Linux 2.1 for Itanium with 
Update 6 

4.0 

 Red Hat Enterprise AS/ES Linux 3 for Itanium with 
Update 4 

4.0 
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Hardware and Software Suggested Minimum Requirements HPPM Version 

 Red Hat Enterprise AS/ES Linux 3 for AMD64 and 
Intel EM64T with Update 4 

4.0 

 SUSE LINUX Enterprise Server 9 for AMD64 and 
Intel EM64T with Service Pack 1 

4.0 

 HP-UX 11.0 for HP 9000 with patch bundle 
HPUX_800_11.0_11081152 

4.0 

 HP-UX 11i v1 for HP 9000 with Errata Kernel 
11.11 

4.0 

 HP-UX 11i v2 for Integrity with Errata Kernel 11.23 4.0 

Server software A supported operating system with a static IP 
address (recommended) and TCP/IP installed and 
configured 

 

 SNMP services installed and active (optional)  

 

The following table lists the Remote Agent minimum hardware and software 
requirements. 

         

Hardware and Software Suggested Minimum Requirements HPPM Version 

Hardware 200-MHz processor  

Disk space 10 MB free disk space  

System memory 64 MB of RAM (180 MB for NetWare 6.0)  

Operating System (32-bit) Microsoft® Windows® XP Professional with 
Service Pack 2 

4.0 

 Microsoft® Small Business Server 2000 with 
Service Pack 4 

4.0 

 Microsoft® Windows® 2000 Server and Advanced 
Server with Service Pack 4 

4.0 

 Microsoft® Windows® Server 2003 Standard 
Edition x86 with Service Pack 1 

4.0 

 Microsoft® Windows® Server 2003 Enterprise 
Edition x86 with Service Pack 1 

4.0 

 Microsoft® Windows® Server 2003 SBS, Standard 
and Premium x86 with Service Pack 1 

4.0 
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Hardware and Software Suggested Minimum Requirements HPPM Version 

 Red Hat Linux 7.3 Professional with Errata Kernel 
2.4.20-28 

4.0 

 Red Hat Linux 8.0 Professional with Errata Kernel 
2.4.20-28 

4.0 

 Red Hat Enterprise Linux 2.1 for x86 with Update 5 4.0 

 Red Hat Enterprise AS/ES Linux 3 for x86 with 
Update 3 

4.0 

 SUSE LINUX Enterprise Server 9 for x86 with 
Errata Kernel 2.6.5-7.104 

4.0 

 Novell NetWare 5.1 with Support Pack 7 4.0 

 Novell NetWare 6.0 with Support Pack 5 4.0 

 Novell NetWare 6.5 with Support Pack 2 4.0 

Operating System (64-bit) Microsoft® Windows® Server 2003 for AMD64 and 
Intel EM64T 

4.0 

 Microsoft® Windows® Server 2003 Enterprise 
Edition For Integrity 

4.0 

 Red Hat Enterprise Linux 2.1 for Itanium with 
Update 5 

4.0 

 Red Hat Enterprise AS/ES Linux 3 for Itanium with 
Update 3 

4.0 

 Red Hat Enterprise AS/ES Linux 3 for AMD64 and 
Intel EM64T with Update 3 

4.0 

 SUSE Linux Enterprise Server 9 for AMD64 and 
Intel EM64T with Errata Kernel 2.6.5-7.104 

4.0 

 HP-UX 11.0 for HP 9000 with patch 4.0 

 HP-UX 11i v1 for HP 9000 with patch 4.0 

 HP-UX 11i v2 for Integrity with patch 4.0 

 
 

Browser Requirements 

The following table lists the minimum browser requirements. 
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NOTE:  For all clients other than HP-UX, browsing requires the use of 
Macromedia Flash Player 6.0, which is included in the Management 
Server installation. If you do not have Flash Player installed, you are 
prompted to install it. Click the link and follow the installation prompts. 

             

Software Browser 

Web browser on a client Microsoft® operating systems 

• Microsoft® Internet Explorer 6.0 with Service 
Pack 1 (32-bit only) 

Red Hat Linux operating system (32-bit only) 

• Mozilla 1.4 

SUSE Linux operating system (32-bit only) 

• Mozilla 1.6 

HP-UX operating system 

• Mozilla 1.4 

Monitor resolution Minimum supported resolution of 1024 x 768, 16-
bit high color (maximize browser window for 
optimal display) 

 
 

Mozilla Settings 

When using SSL with Mozilla, a browser session with the Management Server 
might hang. To resolve the problem, change the following Mozilla settings: 

1. Open the folder into which Mozilla was installed, and under the defaults 
directory, open the pref subdirectory. 

2. Using the text editor, open the file all.js. 

3. Change the entry: 

pref("network.http.max-connections-per-server", 8) 

to read 

pref("network.http.max-connections-per-server, 1) 

4. Save the file, and restart Mozilla. 
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Installation Overview 

Follow these guidelines when installing the HP Power Manager components: 

• Management Server—Install the Management Server on the computer that is 
connected to the UPS serial port or USB port. In a networked configuration, 
you can install the Management Server on any computer on the network that 
is powered by the UPS. This Management Server will communicate with the 
UPS and manage other systems and devices connected to the UPS.  

NOTE:  Devices must be managed by a single Management Server. 

• Remote Agent—Install the Remote Agent on any computer that is powered 
by the UPS. 

For each component, there are three installation options: 

• GUI installation—A series of dialog boxes and prompts guide you through 
the installation process. 

• Non-GUI installation—A series of commands are necessary to complete the 
installation. 

• Silent installation—A preconfigured initialization file is specified during 
installation. This file contains all the information a user is typically prompted 
to enter. 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user 
interaction. During a silent installation you will: 

– Install an HP Power Management Server or Remote Agent through the 
assisted installation method that is appropriate for the operating system. 

– Configure the Management Server exactly as the final replicated systems 
should be configured. Use the exact same UPS model, and thoroughly test 
the configuration, including any alarm or notification events. 

– Use the DevManBE.ini file that is generated in the directory of the 
application as a template in the Management Server silent install process. 

Use the DevManRA.ini file that is generated in the directory of the 
application as a template in the Remote Agent silent install process. 
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– Change any items that should be unique, such as Device Name, 
Management Server Name, or Remote Agent Name, through the normal 
operation of the software. 

The following table summarizes the available installation options for each 
operating system. 

            

Operating 
System 

GUI 
Installation 

Non-GUI 
Installation 

Silent 
Installation 

Local/Remote 
Installation 

Windows® Available - Available - 

Linux - Available Available - 

HP-UX - Available Available Available 

NetWare - Available - - 

 
 

Installing Components on Windows Operating 
Systems 

The Management Server and Remote Agent can be installed using the GUI or 
silent installation methods on any supported Windows® operating system. 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

IMPORTANT:  The Management Server and Remote Agent 
components cannot be installed on the same computer. 

NOTE:  You might need to reboot after installing the Remote Agent on 
Windows®. 

NOTE:  The Management Server and Remote Agent for HP Power 
Manager 4.0 are not backward compatible with earlier versions of HP 
Power Manager. 

 

Installing the Management Server Using the GUI Method 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 
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1. If the Management Server is connected to the UPS through the USB port, 
verify that the UPS is detected by the operating system, and then click OK. 

 

2. Insert the HP Rack and Power Management Pack CD (shipped with each 
UPS) into the CD-ROM drive of the computer. If the AutoPlay feature is 
enabled, the Welcome screen appears. If the AutoPlay feature is disabled, 
explore the CD, and double-click AUTORUN.EXE in the root folder. 

If the software has been downloaded from the HP website 
(http://www.hp.com/products/ups), follow the instructions to unpack the 
files, then locate and run SETUP.EXE. 

3. Select HP Power Manager from the side menu. 

4. Select Management Server. 

The Welcome screen appears. 

http://www.hp.com/products/ups
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5. Read the introduction, and click Next. 

 

The License Agreement screen appears. 
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6. Read the license agreement, select I accept the terms in the license 
agreement, and click Next. 

 

The Customer Information screen appears. 
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7. Verify or change the customer information, select whether to install for all 
users or only the current user, and click Next. 

 

The Destination Folder screen appears. 
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8. Click Next to install the Management Server in the default folder, which is 
displayed below the Install HP Power Manager to: field. To specify a 
different folder, click Change, navigate to the appropriate folder, and click 
Next. 

 

The Ready to Install the Program screen appears. 
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9. Click Install. The wizard installs the software. 
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10. Click Finish to complete the install wizard and continue with the 
configuration process ("Configuring the Management Server" on page 38). 

 
 

Configuring the Management Server 

NOTE:  It might take a moment for the configuration screen to appear. If 
there are open windows on the desktop, you might need to minimize the 
windows to view the configuration screen. 

1. Click Next to use the standard HTTP protocol and port for Web browser 
access to the Management Server. 

2. To use SSL on the standard port, select Use SSL to connect to Manager. To 
use a non-standard port for browser access, change the value in the Web 
Server Port: field. 

3. Verify the port you specify is not already being used. 

4. Click Next. 
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For more information about security considerations, refer to "Security 
Considerations Overview (on page 201)." 

IMPORTANT:  The common Web server port is port 80. The default 
port for SSL is 443. Verify no other Web servers are currently running 
on these ports or the port that you select. Make note of the port number 
for future reference. For port configuration limitations, refer to "Cannot 
Access HPPM After Installation." 

 

NOTE:  To reconfigure the Web connection or communications port or 
to change to a different UPS, refer to "Reconfiguring Components on 
Windows Operating Systems (on page 62)." 
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5. Select the type of connection (Serial, USB, or Network) that is used to attach 
the UPS to the Management Server. 

 

6. Click Next. The next several screens in the configuration program vary, 
depending on the type of connection you selected. 
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Configuring a Serial Port Connected UPS 

1. Select the serial (COM) port that the computer uses to communicate with the 
UPS. Click Next. 
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The configuration program searches for the serial port connected UPS. 
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2. After the configurator detects the UPS, click Finish. 

 

NOTE:  An icon in the Windows® system tray shows the status of the 
connection between the Management Server and the Remote Agent. It 
might take a few moments for the icon to change. A green check mark 

 displays if the Management Server is communicating with the UPS 

without errors. If there are problems, the blue hexagon icon  displays. 
Hover over the icon with the mouse pointer, and a tool tip displays a 
status message. For more information about the system tray icon status 
messages, refer to "System Tray Icon (on page 110)." 
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If the configurator fails to detect the UPS, click Back to check your 
selections. 

 
 



 Installation 45 
 

 

Configuring a USB Port Connected UPS 

The configuration program automatically searches for a USB port connected 
UPS. 
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After the configurator detects the UPS, click Finish. 

 

NOTE:  An icon in the Windows® system tray shows the status of the 
connection between the Management Server and the Remote Agent. It 
might take a few moments for the icon to change. A green check mark 

 displays if the Management Server is communicating with the UPS 

without errors. If there are problems, the blue hexagon icon  displays. 
Hover over the icon with the mouse pointer, and a tool tip displays a 
status message. For more information about the system tray icon status 
messages, refer to "System Tray Icon (on page 110)." 



 Installation 47 
 

 

If the configurator fails to detect the UPS, click Back to check your selections. 

 
 

Configuring a Network Port Connected UPS 

1. Enter the host name or IP address of the network port connected UPS in the 
Hostname field. 

2. Enter the password that is configured in the UPS network adapter in the 
Password field. The password is case-sensitive. The default adapter password 
is MustB6. 

IMPORTANT:  The password you enter must match the password 
configured in the UPS network adapter. If you want to change the 
password, first configure the adapter with the new password, and then 
enter the new password during the Management Server configuration 
process. For more information about configuring the adapter, refer to 
the HP Power Products CD that came with the adapter. 
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3. Click Next. 
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The configuration program searches for the network port connected UPS. 
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4. After the configurator detects the UPS, click Finish. 

 

NOTE:  An icon in the Windows® system tray shows the status of the 
connection between the Management Server and the Remote Agent. It 
might take a few moments for the icon to change. A green check mark 

 displays if the Management Server is communicating with the UPS 

without errors. If there are problems, the blue hexagon icon  displays. 
Hover over the icon with the mouse pointer, and a tool tip displays a 
status message. For more information about the system tray icon status 
messages, refer to "System Tray Icon (on page 110)." 
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If the configurator fails to detect the UPS, click Back to check your 
selections. 

 
 

Installing the Remote Agent Using the GUI Method 

1. Insert the HP Rack and Power Management Pack CD into the CD-ROM 
drive of the computer. If the AutoPlay feature is enabled, the installation 
menu automatically starts. If the AutoPlay feature is disabled, explore the 
CD, and double-click AUTORUN.EXE in the root folder. 

If the software has been downloaded from the HP website 
(http://www.hp.com/products/ups), follow the instructions to unpack the 
files, then locate and run SETUP.EXE. 

2. Select HP Power Manager from the side menu. 

3. Select Remote Agent. 

The Welcome screen appears. 

http://www.hp.com/products/ups
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4. Read the introduction, and click Next. 

 

The License Agreement screen appears. 
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5. Read the license agreement, select I accept the terms in the license 
agreement, and click Next. 

 

The Customer Information screen appears. 
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6. Verify or change the customer information, select whether to install for all 
users or only the current user, and click Next. 

 

The Destination Folder screen appears. 
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7. Click Next to install the Remote Agent in the default folder that is displayed 
below the Install HP Power Manager to: field. To specify a different folder, 
click Change, navigate to the appropriate folder, and click Next. 

 

The Ready to Install the Program screen appears. 
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8. Click Install. The wizard installs the software. 
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9. Click Finish to complete the install wizard and continue with the 
configuration process. 

 

NOTE:  It might take a moment for the configuration screen to appear. If 
there are open windows on the desktop, you might need to minimize the 
windows to view the configuration screen. 

10. For the most security, enter the host name or valid IP address of the 
Management Server. This setting ensures only that particular Management 
Server executes commands and operating system shutdowns on the computer 
running the Remote Agent. 

If security is not a concern, leave this field as is. 
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11. Click Finish. 

 

NOTE:  An icon in the Windows® system tray shows the status of the 
connection between the Management Server and the Remote Agent. It 
might take a few moments for the icon to change. A green check mark 

 displays if the Management Server is communicating with the UPS 

without errors. If there are problems, the blue hexagon icon  displays. 
Hover over the icon with the mouse pointer, and a tool tip displays a 
status message. For more information about the system tray icon status 
messages, refer to "System Tray Icon (on page 110)." 

NOTE:  To reconfigure the Web connection or communications port or 
to change to a different UPS, refer to "Reconfiguring Components on 
Windows Operating Systems (on page 62)." 

 

Installing the Management Server Using the Silent Installation 
Method 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 
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Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Management Server through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Management Server exactly as the final replicated systems 
should be configured. Use the exact same UPS model, and thoroughly test 
the configuration, including any alarm or notification events. 

NOTE:  Configuring the Management Server includes attaching devices 
and configuring the power fail settings, event shutdown settings, and 
event settings. 

• Use the DevManBE.ini file that is generated in the directory of the 
application as a template in the Management Server silent install process. 

NOTE:  To prevent more than one Management Server from managing 
the same devices or agents, a unique DevManBE.ini file is needed for 
each Management Server. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Management Server using the silent installation method: 

1. Create a temporary directory. 

2. Copy the following files into the temporary directory you created using the 
assisted install method: 

– DevManBE.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– Setup.exe—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– Setup.iss—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– SetupBE.exe—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
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3. From the directory that contains all four files, run ./Setup.exe /s 
DevManBE.ini to install silently. 

If the .ini file is not located in the same folder as the Setup file, use the 
switch f option. For example, Setup /s /f <path> 
DevManBE.ini. Replace <path> with the DevManBE.ini file location. 

NOTE:  If you are installing to a location other than the default path 
(szDir=C:\Program Files\HP\Power Manager), edit the destination path 
in the Setup.iss file. 

The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 
         

/s Performs a silent install or upgrade. 

/r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

/f DevManBE.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Installing the Remote Agent Using the Silent Installation Method 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Remote Agent through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Remote Agent exactly as the final replicated systems should 
be configured. 

NOTE:  You must configure the IP address of the Management Server 
in one of two ways: 
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• Leave the IP address field blank to use the same DevManRA.ini file 
for all of your Remote Agent installs. This enable the Remote Agent 
to accept commands from any Management Server that discovers 
the Remote Agent. 

• Create a DevManRA.ini file for each site. This points each UPS to 
the correct Management Server and is the more secure option. 

• Use the DevManRA.ini file that is generated in the directory of the 
application as a template in the Remote Agent silent install process. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Remote Agent using the silent installation method: 

1. Create a temporary directory. 

2. Copy the following files into the temporary directory you just created: 

– DevManRA.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– Setup.exe—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– Setup.iss—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– SetupRA.exe—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

3. From the directory that contains all four files, run ./Setup.exe /s 
DevManRA.ini to install silently. 

If the .ini file is not located in the same folder as the Setup file, use the 
switch f option. For example, Setup /s /f <path> 
DevManRA.ini. Replace <path> with the DevManRA.ini file location. 

The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
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/s Performs a silent install or upgrade. 

/r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

/f DevManRA.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Reconfiguring Components on Windows Operating 
Systems 

• To reconfigure the Management Server Web connection settings, change the 
communications port selection. 

• To change to a different UPS: 

– Right-click the system tray icon on the Management Server to display a 
context menu from which the Management Server service can be stopped 
or started. In this menu, you can also configure new settings using the 
Configure option or launch a browser session using the Connect option. 

-or- 

– Select HP Power Manager Configure from the HP Power Manager 
option in the Start Programs menu on the Management Server. 

• To change the IP address that the Remote Agent uses for the Management 
Server, right-click the system tray icon on the Remote Agent computer to 
display a context menu. 
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Upgrading Management Server Components on 
Windows Operating Systems 

1. Insert the HP Rack and Power Management Pack CD (shipped with each 
UPS) into the CD-ROM drive of the computer. If the AutoPlay feature is 
enabled, the Welcome screen appears. If the AutoPlay feature is disabled, 
explore the CD, and double-click AUTORUN.EXE in the root folder. 

If the software has been downloaded from the HP website 
(http://www.hp.com/products/ups), follow the instructions to unpack the 
files, then locate and run SETUP.EXE. 

2. Select HP Power Manager from the side menu. 

3. Select Management Server. The Setup dialog box appears. 

4. Click Upgrade. 

NOTE:  Upgrading does not delete any previous HPPM custom 
settings. All HPPM custom settings are saved. 

 

The Welcome screen appears. 

http://www.hp.com/products/ups


64  HP Power Manager 4.0 User Guide 
 

 

5. Read the introduction, and click Next. 

 

The License Agreement screen appears. 
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6. Read the license agreement, select I accept the terms in the license 
agreement, and click Next. 

 

The Customer Information screen appears. 
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7. Verify or change the customer information, select whether to install for all 
users or only the current user, and click Next. 

 

The Destination Folder screen appears. 
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8. Click Next to install the Management Server in the default folder, which is 
displayed below the Install HP Power Manager to: field. To specify a 
different folder, click Change, navigate to the appropriate folder, and click 
Next. 

 

The Ready to Install the Program screen appears. 
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9. Click Install. The wizard installs the software. 
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10. Click Finish to complete the install wizard and continue with the 
configuration process ("Configuring the Management Server" on page 38). 

 
 

Upgrading Remote Agent Components on Windows 
Operating Systems 

1. Insert the HP Rack and Power Management Pack CD into the CD-ROM 
drive of the computer. If the AutoPlay feature is enabled, the installation 
menu automatically starts. If the AutoPlay feature is disabled, explore the 
CD, and double-click AUTORUN.EXE in the root folder. 

If the software has been downloaded from the HP website 
(http://www.hp.com/products/ups), follow the instructions to unpack the 
files, then locate and run SETUP.EXE. 

2. Select HP Power Manager from the side menu. 

3. Select Remote Agent. The Setup dialog box appears. 

http://www.hp.com/products/ups
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4. Click Upgrade. 

NOTE:  Upgrading does not delete any previous HPPM custom 
settings. All HPPM custom settings are saved. 

 

The Welcome screen appears. 

5. Read the introduction, and click Next. 

 

The License Agreement screen appears. 
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6. Read the license agreement, select I accept the terms in the license 
agreement, and click Next. 

 

The Customer Information screen appears. 
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7. Verify or change the customer information, select whether to install for all 
users or only the current user, and click Next. 

 

The Destination Folder screen appears. 
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8. Click Next to install the Remote Agent in the default folder that is displayed 
below the Install HP Power Manager to: field. To specify a different folder, 
click Change, navigate to the appropriate folder, and click Next. 

 

The Ready to Install the Program screen appears. 
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9. Click Install. The wizard installs the software. 
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10. Click Finish to complete the install wizard and continue with the 
configuration process. 

 

NOTE:  It might take a moment for the configuration screen to appear. If 
there are open windows on the desktop, you might need to minimize the 
windows to view the configuration screen. 

11. For the most security, enter the host name or valid IP address of the 
Management Server. This setting ensures only that particular Management 
Server executes commands and operating system shutdowns on the computer 
running the Remote Agent. 

If security is not a concern, leave this field as is. 
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12. Click Finish. 

 

NOTE:  An icon in the Windows® system tray shows the status of the 
connection between the Management Server and the Remote Agent. It 
might take a few moments for the icon to change. A green check mark 

 displays if the Management Server is communicating with the UPS 

without errors. If there are problems, the blue hexagon icon  displays. 
Hover over the icon with the mouse pointer, and a tool tip displays a 
status message. For more information about the system tray icon status 
messages, refer to "System Tray Icon (on page 110)." 

NOTE:  To reconfigure the Web connection or communications port or 
to change to a different UPS, refer to "Reconfiguring Components on 
Windows Operating Systems (on page 62)." 

 

Installing Components on Linux Operating Systems 

The Management Server and Remote Agent can be installed using an installation 
script or the silent installation option on any supported Linux operating system. 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 
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NOTE:  The Management Server and Remote Agent components 
cannot be installed on the same computer. 

NOTE:  The Management Server and Remote Agent for HP Power 
Manager 4.0 are not backward compatible with earlier versions of HP 
Power Manager. 

 

Installing the Management Server Using the Installation Script 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

1. HPPM can be loaded 2 ways: 

– If loading the software from the HP Rack and Power Management CD, 
insert the CD into the CD-ROM drive of the computer. From the console 
or a terminal window, go to the HPPM/...Linux/Manager subdirectory. 
Execute the following installation script: 

./Setup 

– If the downloading the software from the HP website, follow the 
instructions on the website to unpack the files. Locate the Linux 
Management Server installation script (Setup). Execute the following 
script: 

./Setup 
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The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

 

The installer launches a separate configuration program. 

The script displays: Do you wish to use SSL to communicate 
with HP Power Manager? 

2. To use the standard HTTP protocol for Web browser access to the 
Management Server, enter n. To use the SSL, enter y.  

For more information about security considerations, refer to "HP Power 
Manager Security Considerations Overview (on page 201)." 

The script displays: Please enter a port to use for web 
connections. 

3. To use standard TCP/IP port (80 for HTTP, 443 for SSL) with the selected 
protocol for Web browser access to the Management Server, press the Enter 
key. To use a non-standard port for browser access, enter a valid numerical 
value for the port number. 
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The script displays: Please select a serial port to search 
for a UPS device on. 

4. If the serial cable from the UPS is connected to serial port /dev/ttyS0 on the 
computer, press the Enter key. If it is connected to a different serial port, 
enter the number corresponding to that serial port from the displayed list. 

If a UPS is discovered, the type of communications protocol and baud rate is 
displayed. If no UPS is detected, verify that the cable is connected securely 
from the serial port to the UPS and that the correct port was selected before 
trying again. 

 

Installing the Remote Agent Using the Installation Script 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. HPPM can be loaded 2 ways: 

– If loading the software from the HP Rack and Power Management CD, 
insert the CD into the CD-ROM drive of the computer. From the console 
or a terminal window, go to the HPPM/...Linux/Manager subdirectory. 
Execute the following installation script: 

./Setup 

– If the downloading the software from the HP website, follow the 
instructions on the website to unpack the files. Locate the Linux 
Management Server installation script (Setup). Execute the following 
script: 

./Setup 

The script installs the Remote Agent component and requests information to 
configure the application. Default values or valid options are shown in 
brackets following each prompt. 

The installer launches a separate configuration program. 

The script displays: Please enter a server to allow 
connections from. 

2. For the most security, enter the host name or IP address of the Management 
Server. This configuration ensures only that particular Management Server 
executes commands and operating system shutdowns on the computer 
running the Remote Agent. 
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If security is not a concern, enter an asterisk and press the Enter key. 

 
 

Installing the Management Server Using the Silent Installation 
Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Management Server through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Management Server exactly as the final replicated systems 
should be configured. Use the exact same UPS model, and thoroughly test 
the configuration, including any alarm or notification events. 

NOTE:  Configuring the Management Server includes attaching devices 
and configuring the power fail settings, event shutdown settings, and 
event settings. 

• Use the DevManBE.ini file that is generated in the directory of the 
application as a template in the Management Server silent install process. 
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NOTE:  To prevent more than one Management Server from managing 
the same devices or agents, a unique DevManBE.ini file is needed for 
each Management Server. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Management Server on a Linux system using the silent installation 
method: 

1. Create a temporary directory. 

2. Copy the following files into the temporary directory you just created: 

– DevManBE.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– EULA.txt—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– Setup—This file is included with the installation files on the HP Power 
Management Pack CD and the software download package on the HP 
website (http://www.hp.com/products/ups). 

– Uninstall—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– PowerManager-4.0-10.i586.rpm—This file is included with the 
installation files on the HP Power Management Pack CD and the software 
download package on the HP website (http://www.hp.com/products/ups). 

3. From the directory that contains all five files, run ./HPPMInstall -s 
DevManBE.ini to install silently. 

If the .ini file is not located in the same folder as the Setup file, use the 
switch f option. For example, Setup -s -f <path> 
DevManBE.ini. Replace <path> with the DevManBE.ini file location. 

The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 
         

-s Performs a silent install or upgrade. 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
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-r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

-log Creates an installation log 
(/user/local/DevMan/setup.log). Default is disabled 
for interactive mode and enabled for silent mode. 
This option is supported only on Linux. The 
installation log is created automatically for 
Windows® during silent installations in 
\%systemdrive%\setup.log. 

-f DevManBE.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Installing the Remote Agent Using the Silent Installation Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Remote Agent through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Remote Agent exactly as the final replicated systems should 
be configured. 

NOTE:  You must configure the IP address of the Management Server 
in one of two ways: 
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• Leave the IP address field blank to use the same DevManRA.ini file 
for all of your Remote Agent installs. This enable the Remote Agent 
to accept commands from any Management Server that discovers 
the Remote Agent. 

• Create a DevManRA.ini file for each site. This points each UPS to 
the correct Management Server and is the more secure option. 

• Use the DevManRA.ini file that is generated in the directory of the 
application as a template in the Remote Agent silent install process. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Remote Agent using the silent installation method: 

1. Create a temporary directory. 

2. Copy the following files into the temporary directory you just created: 

– DevManRA.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– EULA.txt—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– Setup—This file is included with the installation files on the HP Power 
Management Pack CD and the software download package on the HP 
website (http://www.hp.com/products/ups). 

– Uninstall—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– PowerManagerRA-4.0-10.i586.rpm—This file is included with the 
installation files on the HP Power Management Pack CD and the software 
download package on the HP website (http://www.hp.com/products/ups). 

3. From the directory that contains all five files, run ./Setup.exe -s 
DevManRA.ini to install silently. 

If the .ini file is not located in the same folder as the Setup file, use the 
switch f option. For example, Setup -s -f <path> 
DevManRA.ini. Replace <path> with the DevManRA.ini file location. 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
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The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 
         

-s Performs a silent install or upgrade. 

-r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

-log Creates an installation log 
(/user/local/DevMan/setup.log). Default is disabled 
for interactive mode and enabled for silent mode. 
This option is supported only on Linux. The 
installation log is created automatically for 
Windows® during silent installations in 
\%systemdrive%\setup.log. 

-f DevManRA.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Reconfiguring Management Server Components on 
Linux Operating Systems 

To configure the Web connection, SSL, or communications port, run 
/etc/init.d/DevMan setup. 
 

Reconfiguring Remote Agent Components on Linux 
Operating Systems 

To configure the Management Server IP address or hostname, run 
/etc/init.d/DevMan setup. 
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Upgrading Management Server Components on 
Linux Operating Systems 

Upgrade HPPM using one of the following methods: 

• If upgrading the software from CD, insert the CD into the CD-ROM drive of 
the computer. From the console or a terminal window, go to the 
HPPM/...Linux/Manager subdirectory. Execute the following installation 
script: 

./Setup -s 

No output appears in the terminal. 

• If downloading the software from the HP website 
(http://www.hp.com/products/ups), follow the instructions on the website to 
unpack the files. Locate the Linux Management Server installation script 
(Setup). Execute the following script:  

./Setup -s 

No output appears in the terminal. 

The script installs the newest version of the Management Server, keeping all old 
settings intact. 
 

Upgrading Remote Agent Components on Linux 
Operating Systems 

Upgrade HPPM using one of the following methods: 

• If upgrading the software from CD, insert the CD into the CD-ROM drive of 
the computer. From the console or a terminal window, go to the 
HPPM/...Linux/Agent subdirectory. Execute the following installation script: 

./SetupRA -s 

No output appears in the terminal. 

http://www.hp.com/products/ups
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• If downloading the software from the HP website 
(http://www.hp.com/products/ups), follow the instructions on the website to 
unpack the files. Locate the Linux Remote Agent installation script 
(SetupRA). Execute the following script:  

./SetupRA -s 

No output appears in the terminal. 

The script installs the newest version of the Remote Agent, keeping all old 
settings intact. 
 

Installing Components on HP-UX Operating Systems 

The Management Server and Remote Agent can be installed using an installation 
script, SAM, or silent installation option on any supported HP-UX operating 
system. 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  The Management Server and Remote Agent components 
cannot be installed on the same computer. 

NOTE:  The Management Server and Remote Agent for HP Power 
Manager 4.0 are not backward compatible with earlier versions of HP 
Power Manager. 

 

Installing the Management Server Locally Using the Installation 
Script Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

1. HPPM can be loaded two ways: 

– If loading the software from the HP Rack and Power Management CD, 
insert the CD into the CD-ROM drive of the computer. From the console 
or a terminal window, go to the HPPM/...HP-UX/Manager subdirectory. 
Execute the following installation script: 

http://www.hp.com/products/ups
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./HPPMInstall 

– If the downloading the software from the HP website, follow the 
instructions on the website to unpack the files. Locate the installation 
script (HPPMInstall). Execute the following script: 

./HPPMInstall 

The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

 

The script displays the EULA.  

2. To accept the EULA, enter y. 
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The script displays: Do you wish to use SSL to communicate 
with HP Power Manager? 

3. To use the standard HTTP protocol for Web browser access to the 
Management Server, enter n. To use SSL, enter y. 

IMPORTANT:  If you choose to implement SSL with HPPM, ensure that 
you have HP-UX Strong Random Number Generator installed on the 
HP-UX system running the Management Server component. This is 
needed to generate a unique SSL certificate. 

For more information about security considerations, refer to "Security 
Considerations Overview (on page 201)." 

The script displays: Please enter a port to use for web 
connections. 

4. To use standard TCP/IP port (80 for HTTP, 443 for SSL) with the selected 
protocol for Web browser access to the Management Server, press the Enter 
key. To use a non-standard port for browser access, enter a valid numerical 
value for the port number. 

The script displays: Please select a serial port to search 
for a UPS device on. 

5. If the serial cable from the UPS is connected to serial port /dev/ttyS0 on the 
computer, press the Enter key. If it is connected to a different serial port, 
enter the number corresponding to that serial port from the displayed list. 

If a UPS is discovered, the type of communications protocol and baud rate is 
displayed. If no UPS is detected, verify that the cable is connected securely 
from the serial port to the UPS and that the correct port was selected before 
trying again. 

 

Installing the Remote Agent Locally Using the Installation Script 
Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. HPPM can be loaded two ways: 
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– If loading the software from the HP Rack and Power Management CD, 
insert the CD into the CD-ROM drive of the computer. From the console 
or a terminal window, go to the HPPM/...HP-UX/Manager subdirectory. 
Execute the following installation script: 

./HPPMInstall 

– If the downloading the software from the HP website, follow the 
instructions on the website to unpack the files. Locate the installation 
script (HPPMInstall). Execute the following script: 

./HPPMInstall 

The script installs the Remote Agent component and requests information to 
configure the application. Default values or valid options are shown in 
brackets following each prompt. 

 

The script displays the EULA.  

2. To accept the EULA, enter y. 
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The script displays: Please enter a server to allow 
connections from.  

3. Enter an asterisk to allow any server to connect to this agent, or enter the host 
name or IP address of the Management Server. 

 

Installing the Management Server Locally Using the SAM Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

1. From the SAM application, double-click Software Management. 

2. Click Install Software to Local Host. 

3. Change the Source Depot Path to a fully qualified path and depot name. 

4. Select the HP Power Manager you are about to install.  

5. Click Actions>Install from the top menu. 

6. Click OK to analyze the depot file. 

7. Click OK to install the depot file. 

8. Click Done to complete the installation and continue with the configuration 
process. 

9. Enter /sbin/init.d/DevMan setup in the terminal, and press the 
Enter key. 

The installer launches a separate configuration program. 

The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

The script displays: Do you wish to use SSL to communicate 
with HP Power Manager? 

10. To use the standard HTTP protocol for Web browser access to the 
Management Server, enter n. To use SSL, enter y. 
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IMPORTANT:  If you choose to implement SSL with HPPM, ensure that 
you have HP-UX Strong Random Number Generator installed on the 
HP-UX system running the Management Server component. This is 
needed to generate a unique SSL certificate. 

For more information about security considerations, refer to "Security 
Considerations Overview (on page 201)." 

The script displays: Please enter a port to use for web 
connections. 

11. To use standard TCP/IP port (80 for HTTP, 443 for SSL) with the selected 
protocol for Web browser access to the Management Server, press the Enter 
key. To use a non-standard port for browser access, enter a valid numerical 
value for the port number. 

The script displays: Please select a serial port to search 
for a UPS device on. 

If a UPS is discovered, the type of communications protocol and baud rate is 
displayed. If no UPS is detected, verify that the cable is connected securely 
from the serial port to the UPS and that the correct port was selected before 
trying again. 

 

Installing the Remote Agent Locally Using the SAM Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. From the SAM application, double-click Software Management. 

2. Click Install Software to Local Host. 

3. Change the Source Depot Path to a fully qualified path and depot name. 

4. Select the HP Power Manager you are about to install.  

5. Click Actions>Install... from the top menu. 

6. Click OK to analyze the depot file. 

7. Click OK to install the depot file. 

8. Click Done to complete the installation and continue with the configuration 
process. 

9. Enter /sbin/init.d/DevMan setup in the terminal, and press the 
Enter key. 
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The installer launches a separate configuration program. 

The script installs the Remote Agent component and requests information to 
configure the application. Default values or valid options are shown in 
brackets following each prompt. 

The script displays the EULA.  

10. To accept the EULA, enter y. 

The script displays: Please enter a server to allow 
connections from.  

11. For the most security, enter the IP address of the Management Server. This 
configuration ensures only that particular Management Server executes 
commands and operating system shutdowns on the computer running the 
Remote Agent. 

 

Installing the Management Server Remotely Using the 
Installation Script Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

1. Find the server on the network, and log in as a super user. Locate the HP-UX 
Management Server installation script (HPPM Install), and execute: 

./HPPMInstall. 
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The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

 

The script displays the EULA.  

2. To accept the EULA, enter y to continue. 

The script displays: Do you wish to use SSL to communicate 
with HP Power Manager? 

3. To use the standard HTTP protocol for Web browser access to the 
Management Server, enter n. To use the SSL, enter y. 
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IMPORTANT:  If you choose to implement SSL with HPPM, ensure that 
you have HP-UX Strong Random Number Generator installed on the 
HP-UX system running the Management Server component. This is 
needed to generate a unique SSL certificate. 

For more information about security considerations, refer to "Security 
Considerations Overview (on page 201)." 

The script displays: Please enter a port to use for web 
connections. 

4. To use standard TCP/IP port (80 for HTTP, 443 for SSL) with the selected 
protocol for Web browser access to the Management Server, press the Enter 
key. To use a non-standard port for browser access, enter a valid numerical 
value for the port number. 

The script displays: Please select a serial port to search 
for a UPS device on. 

5. If a UPS is discovered, the type of communications protocol and baud rate is 
displayed. If no UPS is detected, verify that the cable is connected securely 
from the serial port to the UPS and that the correct port was selected before 
trying again. 

 

Installing the Remote Agent Remotely Using the Installation 
Script Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. Find the server on the network, and log in as a super user. Locate the HP-UX 
Remote Agent installation script (HPPM Install) and execute: 

./HPPMInstall 
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The script installs the Remote Agent component and requests information to 
configure the application. Default values or valid options are shown in 
brackets following each prompt. 

 

The script displays the EULA.  

2. To accept the EULA, enter y. 

The script displays: Please enter a server to allow 
connections from.  

3. Enter an asterisk to allow any server to connect to this agent, or enter the host 
name or IP address of the Management Server. 

 

Installing the Management Server Remotely Using the SAM 
Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 



96  HP Power Manager 4.0 User Guide 
 

 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

1. From a remote machine, enter sam at the command line prompt. 

2. Click Software Management. 

3. Click Install Software to Local Host. 

4. Change the Source Depot Path to a fully qualified path and depot name. 

5. Select the HP Power Manager you are about to install.  

6. Select Actions>Install from the top menu, and click OK and Done. 

7. Click OK to analyze the depot file. 

8. Click OK to install the depot file. 

9. Click Done to complete the installation and continue with the configuration 
process. 

10. Enter /sbin/init.d/DevMan setup in the terminal, and press the 
Enter key. 

The installer launches a separate configuration program. 

The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

The script displays: Do you wish to use SSL to communicate 
with HP Power Manager? 

11. To use the standard HTTP protocol for Web browser access to the 
Management Server, enter n. To use SSL, enter y. 

IMPORTANT:  If you choose to implement SSL with HPPM, ensure that 
you have HP-UX Strong Random Number Generator installed on the 
HP-UX system running the Management Server component. This is 
needed to generate a unique SSL certificate. 

For more information about security considerations, refer to "Security 
Considerations Overview (on page 201)." 

The script displays: Please enter a port to use for web 
connections. 
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12. To use standard TCP/IP port (80 for HTTP, 443 for SSL) with the selected 
protocol for Web browser access to the Management Server, press the Enter 
key. To use a non-standard port for browser access, enter a valid numerical 
value for the port number. 

The script displays: Please select a serial port to search 
for a UPS device on. 

13. If a UPS is discovered, the type of communications protocol and baud rate is 
displayed. If no UPS is detected, verify that the cable is connected securely 
from the serial port to the UPS and that the correct port was selected before 
trying again. 

 

Installing the Remote Agent Remotely Using the SAM Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. From a remote machine, enter sam at the command line prompt. 

2. Click Software Management. 

3. Click Install Software to Local Host. 

4. Change the Source Depot Path to a fully qualified path and depot name. 

5. Select the HP Power Manager you are about to install.  

6. Select Actions>Install from the top menu, and click OK and Done. 

7. Click OK to analyze the depot file. 

8. Click OK to install the depot file. 

9. Click Done to complete the installation and continue with the configuration 
process. 

10. Enter /sbin/init.d/DevMan setup in the terminal, and press the 
Enter key. 

The installer launches a separate configuration program. 

The script installs the Management Server component and requests 
information to configure the application. Default values or valid options are 
shown in brackets following each prompt. 

The script displays the EULA.  
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11. To accept the EULA, enter y. 

The script displays: Please enter a server to allow 
connections from.  

12. Enter an asterisk to allow any server to connect to this agent, or enter the host 
name or IP address of the Management Server. 

 

Installing the Management Server Using the Silent Installation 
Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

NOTE:  Before installing the software, be sure that the serial, USB, or 
network cable connecting the UPS to the Management Server is 
properly installed. 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Management Server through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Management Server exactly as the final replicated systems 
should be configured. Use the exact same UPS model, and thoroughly test 
the configuration, including any alarm or notification events. 

NOTE:  Configuring the Management Server includes attaching devices 
and configuring the power fail settings, event shutdown settings, and 
event settings. 

• Use the DevManBE.ini file that is generated in the directory of the 
application as a template in the Management Server silent install process. 

NOTE:  To prevent more than one Management Server from managing 
the same devices or agents, a unique DevManBE.ini file is needed for 
each Management Server. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Management Server on a system running HP-UX using the silent 
installation method: 
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1. Create a temporary directory. 

2. Copy the following files into the temporary directory you just created: 

– DevManBE.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– EULA—This file is included with the installation files on the HP Power 
Management Pack CD and the software download package on the HP 
website (http://www.hp.com/products/ups). 

– HPPMInstall—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– HPPMUninstall—This file is included with the installation files on the 
HP Power Management Pack CD and the software download package on 
the HP website (http://www.hp.com/products/ups). 

– HPPM4Build9HPUX.depot—This file is included with the installation 
files on the HP Power Management Pack CD and the software download 
package on the HP website (http://www.hp.com/products/ups). 

3. From the directory that contains all five files, run ./HPPMInstall -s 
DevManBE.ini to install silently. 

If the .ini file is not located in the same folder as the HPPMInstall file, use 
the switch f option. For example, HPPMInstall -s -f <path> 
DevManBE.ini. Replace <path> with the DevManBE.ini file location. 

The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 
         

-s Performs a silent install or upgrade. 

-r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

-log Creates an installation log 
(/user/local/DevMan/setup.log). Default is disabled 
for interactive mode and enabled for silent mode. 
This option is supported only on Linux. The 
installation log is created automatically for 
Windows® during silent installations in 
\%systemdrive%\setup.log. 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups


100  HP Power Manager 4.0 User Guide 
 

 

-f DevManBE.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Installing the Remote Agent Using the Silent Installation Method 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

Silent installation is typically used by system administrators who have many 
installations that are configured identically and require minimal user interaction. 
During a silent installation you will: 

• Install a Remote Agent through the assisted installation method that is 
appropriate for the operating system. 

• Configure the Remote Agent exactly as the final replicated systems should 
be configured. 

NOTE:  You must configure the IP address of the Management Server 
in one of two ways: 

• Leave the IP address field blank to use the same DevManRA.ini file 
for all of your Remote Agent installs. This enable the Remote Agent 
to accept commands from any Management Server that discovers 
the Remote Agent. 

• Create a DevManRA.ini file for each site. This points each UPS to 
the correct Management Server and is the more secure option. 

• Use the DevManRA.ini file that is generated in the directory of the 
application as a template in the Remote Agent silent install process. 

• Change any items that should be unique, such as Device Name, Management 
Server Name, or Remote Agent Name, through the normal operation of the 
software. 

To install the Remote Agent on a system running HP-UX using the silent 
installation method: 

1. Create a temporary directory. 
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2. Copy the following files into the temporary directory you just created: 

– DevManRA.ini—During an assisted install, this file is landed in the same 
folder in which HP Power Manager is installed. 

– EULA—This file is included with the installation files on the HP Power 
Management Pack CD and the software download package on the HP 
website (http://www.hp.com/products/ups). 

– HPPMInstall—This file is included with the installation files on the HP 
Power Management Pack CD and the software download package on the 
HP website (http://www.hp.com/products/ups). 

– HPPMUninstall—This file is included with the installation files on the 
HP Power Management Pack CD and the software download package on 
the HP website (http://www.hp.com/products/ups). 

– HPPM4Build9HPUX.depot—This file is included with the installation 
files on the HP Power Management Pack CD and the software download 
package on the HP website (http://www.hp.com/products/ups). 

3. From the directory that contains all five files, run ./HPPMInstall -s 
DevManRA.ini to install silently. 

If the .ini file is not located in the same folder as the HPPMInstall file, use 
the switch f option. For example, HPPMInstall -s -f <path> 
DevManRA.ini. Replace <path> with the DevManRA.ini file location. 

The following command line parameters can be specified and are applicable for 
both interactive and silent modes. 
         

-s Performs a silent install or upgrade. 

-r Reboots the computer at completion of setup. This 
option is supported only on Windows® and only for 
a silent install or upgrade. 

-log Creates an installation log 
(/user/local/DevMan/setup.log). Default is disabled 
for interactive mode and enabled for silent mode. 
This option is supported only on Linux. The 
installation log is created automatically for 
Windows® during silent installations in 
\%systemdrive%\setup.log. 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
http://www.hp.com/products/ups
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-f DevManRA.ini Specifies a configuration .ini file used for both 
upgrades and clean installs. When this option is 
specified, the device detection and configuration 
step is omitted. If this option is specified for the 
upgrade, it overwrites any saved .ini file settings. 
This parameter is required for silent installations but 
is optional for upgrading. 

 
 

Reconfiguring Management Server Components on 
HP-UX Operating Systems 

To reconfigure the Web connection, SSL, or communications port, run 
/sbin/init.d/DevMan setup. 
 

Reconfiguring Remote Agent Components on HP-UX 
Operating Systems 

To reconfigure the Management Server IP address or hostname, run 
/sbin/init.d/DevMan setup. 
 

Upgrading Management Server Components on HP-
UX Operating Systems 

Upgrade HPPM using one of the following methods: 

• If upgrading the software from CD, insert the CD into the CD-ROM drive of 
the computer. From the console or a terminal window, go to the 
HPPM/...HPUX/Manager subdirectory. Execute the following installation 
script: 

./HPPMInstall -s 

No output appears in the terminal. 
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• If downloading the software from the HP website 
(http://www.hp.com/products/ups), follow the instructions on the website to 
unpack the files. Locate the HPUX Management Server installation script 
(HPPMInstall). Execute the following script:   

./HPPMInstall -s 

No output appears in the terminal. 

The script installs the newest version of the Management Server, keeping all old 
settings intact. 
 

Upgrading Remote Agent Components on HP-UX 
Operating Systems 

Upgrade HPPM using one of the following methods: 

• If upgrading the software from CD, insert the CD into the CD-ROM drive of 
the computer. From the console or a terminal window, go to the 
HPPM/...HPUX/Agent subdirectory. Execute the following installation 
script: 

./HPPMInstall -s 

No output appears in the terminal. 

• If downloading the software from the HP website 
(http://www.hp.com/products/ups), follow the instructions on the website to 
unpack the files. Locate the HPUX Remote Agent installation script 
(HPPMInstall). Execute the following script:  

./HPPMInstall -s 

No output appears in the terminal. 

The script installs the newest version of the Remote Agent, keeping all old 
settings intact. 
 

http://www.hp.com/products/ups
http://www.hp.com/products/ups
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Installing Components on NetWare Operating 
Systems 

The Remote Agent can be installed using a configuration module or the silent 
installation option on any supported NetWare operating system. 

NOTE:  If DNS is not being used, verify the host name and IP address 
are added to the hosts file (sys:etc\hosts). 

NOTE:  The Management Server and Remote Agent for HP Power 
Manager 4.0 are not backward compatible with earlier versions of HP 
Power Manager. 

 

Installing the Remote Agent Using the Configuration Module 

IMPORTANT:  To ensure your system has the minimum requirements 
needed to run HPPM, refer to "System Requirements (on page 25)." 

1. If loading the software from the HP Rack and Power Management CD, insert 
CD into the CD-ROM drive of the computer. From the 
HPPM/...NetWare/Agent subdirectory of the CD, copy the contents into a 
directory on the NetWare server, and then unzip the files. 

From the NetWare system console, load the configuration module 
(PMCONFIG.NLM) using the full path. For example, if the files were copied 
into a folder called HP on the SYS: volume, the module would be loaded as 
follows: 

SYS:HP/PMCONFIG 

If the software has been downloaded from the HP website 
(http://www.hp.com/products/ups), follow the instructions on the website to 
unpack the files. Copy the files to the NetWare server. From the NetWare 
system console, load the configuration module (PMCONFIG.NLM) using 
the default path. For example, if the files were copied into a folder called HP 
on the SYS: volume, the module would be loaded as follows: 

SYS:HP/PMCONFIG 

http://www.hp.com/products/ups
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The module displays information about the configuration process. 

 

2. Press the Enter key to continue the installation. 

 

The License Agreement screen appears. 
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3. Enter accept to accept the license agreement. 

 

The module displays: Enter the IP address of the 
Management Server. 

4. For the most security, enter the host name or IP address of the Management 
Server. This configuration ensures only that particular Management Server 
executes commands and operating system shutdowns on the computer 
running the Remote Agent. 

If security is not a concern, enter an asterisk, and press the Enter key. 

5. Enter y to start the Remote Agent. 

6. Press the Enter key to close the installation module. 
 

Uninstalling Components from Windows® Systems 
1. Click Start>Settings>Control Panel. 

2. Open Add/Remove Programs. 

3. Select HP Power Manager or HP Power Manager Remote Agent, and 
click Change/Remove. 
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The uninstall wizard launches. 

Select Remove Choice, and click Next. 

4. Follow the prompts in the uninstall wizard to uninstall the software. 

NOTE:  Some files might remain following the uninstallation and can be 
removed manually. 

 

Uninstalling Components from Linux Systems 

Execute the uninstall script (Uninstall). 

NOTE:  Some files might remain following the uninstallation and can be 
removed manually. 

 

Uninstalling Components from HP-UX Systems 

Execute the uninstall script (HPPMUninstall). 

NOTE:  Some files might remain following the uninstallation and can be 
removed manually. 

 

Uninstalling Components from NetWare Systems 

Navigate to the directory into which the software was installed and load 
PMCONFIG.NLM with the -u option. 

For example: SYS:HPPM/PMCONFIG -u 

NOTE:  Some files might remain following the uninstallation and can be 
removed manually. 
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Access and Navigation 

In this section 

Accessing the Software ..............................................................................................................109
Regarding the Browser Security Alert........................................................................................110
Logging In ..................................................................................................................................113
Navigating ..................................................................................................................................114

 
 

Accessing the Software 

You can access the software: 

• Remotely through a Web browser (on page 109) 

• Locally from the system tray icon (on page 110) in Windows® 
 

Web Browser 

To access the Management Server software through a Web browser: 

1. Launch a supported browser. The browser window appears. 

2. In the Address field (Microsoft Internet Explorer) or the Location field 
(Mozilla), enter an IP address. Use the following examples, where hostname 
is the IP address or the machine name of the computer on which the 
Management Server software component is installed. 

– If you installed the software to use the default port numbers of 80 
(standard HTTP) or 443 (SSL), enter one of the following: 

http://hostname 

https://hostname 

– If you installed the software to use a specific port number that is different 
from the defaults, use the following example with the port number you 
selected. 

http://hostname:1234/ 
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https://hostname:1234/ 

NOTE:  If you are using a proxy server, you might need to add the 
server hosting the software to the No Proxy list of servers in the Internet 
settings for your browser. Refer to the browser help for more information 
about changing the configuration. 

 

System Tray Icon 

To access the software through the system tray in Windows®: 

1. Right-click the software system tray icon on a computer with one of the 
software components installed to display a context menu. 

2. Click Connect to access the software. 

NOTE:  If the  icon appears, the Connect option is unavailable 
because the service is unavailable. 

              

Icon Status 

 
Software service/daemon is running. 

The agent and Management Server are communicating. 

UPS status is normal. 

 
Software service/daemon is not running. 

 
UPS issues a warning alarm. 

 
Software is not configured, the UPS is not connected, or the agent 
and Management Server are not communicating. 

UPS issues a critical alarm. 

 
 

Regarding the Browser Security Alert 
NOTE:  The information in this section is only applicable if SSL is 
chosen during software configuration. 
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Secure browsing requires the use of SSL. SSL is a protocol layer that lies 
between HTTP and TCP that provides secure communication between a server 
and a client and is designed to provide privacy and message integrity. SSL is 
commonly used in Web-based transactions to authenticate the Web server, which 
indisputably identifies the server to the browser. SSL also provides an encrypted 
channel of communication between the server and the browser. The encrypted 
channel ensures integrity of the data between the Web server and the browser, so 
that data can neither be viewed nor modified while in transit. HPPM uses a 
system generated and unique key. 

An integral part of SSL is a security certificate, which identifies the Management 
Server. If your browser displays a security alert when browsing to the software, it 
can be for one of several reasons: 

• The certificate is untrusted, meaning it was signed by a certifying authority 
that is unknown to your browser. 

• The certificate has expired or is not yet valid. This condition can occur if you 
issue your own certificate and it has expired. 

• The name on the certificate does not match the name of the site in the 
browser address field. 

For more information about security considerations, refer to HP Power Manager 
Security Considerations Overview (on page 201). 
 

Establishing a Secure Session for Internet Explorer 

The first time you browse to the software, the Secure Session screen appears. To 
ensure a secure connection, verify that you are browsing to the desired 
Management Server: 

1. Click View Certificate. 

2. Verify that the name in the Issued To field is the name of your Management 
Server. 

3. Perform any other steps necessary to verify the identity of the Management 
Server. 
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 CAUTION:  If you are not sure this is the desired Management 
Server, do not proceed. Importing a certificate from an unauthorized 
server relays your login credentials to that unauthorized server. Exit the 
certificate window and contact the software administrator. 

After verifying the Management Server, do one of the following: 

• Import the certificate and proceed. 

a. Click View Certificate. The certificate appears. 

b. Click Install Certificate. The Certificate Import wizard runs. 

c. Click Next. The Certificate Store screen appears. 

d. Select Automatically select the certificate store based on the type of 
certificate, and click Next. 

e. Click Finish. A message appears, asking for verification of the root 
store. 

f. Click Yes. 
 

• Proceed without importing the certificate by clicking Yes at the Security 
Alert window. You continue to receive the Security Alert each time you log 
in until you import the certificate. Your data is still encrypted. 

• Exit and import the certificate into your browser from a file provided by the 
administrator. 

a. Click No at the Security Alert window. 

b. Obtain an exported software server certificate file from the administrator. 

NOTE:  If using Internet Explorer, you can manually import the file into 
the browser by clicking Tools>Internet 
Options>Content>Certificates>Import. 

 

Establishing a Secure Session for Mozilla 

The first time you browse to the software, the Secure Session screen appears. To 
ensure a secure connection, verify that you are browsing to the desired 
Management Server: 

1. Click Examine Certificate. 
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2. Verify that the name in the Issued To field is the name or IP address of your 
Management Server. 

3. Perform any other steps necessary to verify the identity of the Management 
Server. 

4. After verifying the Management Server, do one of the following: 

a. Click either Accept this certificate permanently or Accept this 
certificate temporally for this session. 

b. Click OK. 

NOTE:  If using Mozilla, you can manually import the file into the 
browser by clicking File>Preferences>Certificates>Privacy & 
Security>Manage Certificates>Authorities>Import. 

 

Logging In 

Before using this software, log in with a user name and password. The first time 
you log in, enter admin as the user name, and enter admin as the password. 
Click Submit Login to log in. After you are logged in, you can change your 
password. For more information, refer to "My Account Menu Option (on page 
167)." 

NOTE:  Passwords are case-sensitive. 

 

After a successful login, the Overview screen under the Home tab appears. For 
more information on the Overview screen, refer to "Overview Menu Option (on 
page 117)." 
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Navigating 

The software interface is divided into three frames: 

• Top frame—Contains the HP logo, Home, Logs, Setup, and Help tabs, as 
well as a Logout hyperlink. 

– Click the HP logo to access the HP website. 

– Click the Home tab to see the menu options for configuring and operating 
the software. For more information, refer to "Home Tab (on page 117)." 

– Click the Logs tab to see the menu options for displaying UPS data logs. 
For more information, refer to "Logs Tab (on page 155)." 

– Click the Setup tab to see the menu options for setting up and modifying 
user accounts. For more information, refer to "Setup Tab (on page 167)." 

– Click the Help tab to access the software help section. For more 
information, refer to "Help Tab (on page 169)." 

– Click the Logout hyperlink to log out of the software. 

NOTE:  An indicator in the upper right corner of the screen displays 
information about the UPS, such as the number of active alarms or 
whether the UPS is connected. 

• Left navigation frame—Contains a list of menu options on the left side of 
the screen. The menu is dynamic, and the menu options change depending on 
the tab selected and your access rights. 

• Main frame—Contains the various software screens based on the menu 
option selected. 
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NOTE:  The Overview screen appears in the main frame the first time 
you log in to the software. The screen might vary, depending on the 
UPS model connected. 
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Configuration and Operation 

In this section 

Home Tab ...................................................................................................................................117
 
 

Home Tab 

Menu options listed under the Home tab include: 

• Overview Menu Option (on page 117) 

• Alarms Menu Option (on page 123) 

• Identification Menu Option (on page 123) 

• Parameters Menu Option (on page 124) 

• Attached Devices Menu Option (on page 126) 

• Power Fail Menu Option (on page 133) 

• Shutdown Events Menu Option (on page 138) 

• Scheduled Shutdown Menu Option (on page 140) 

• Event Settings Menu Option (on page 143) 

• Manual Control Menu Option (on page 150) 

• Settings Menu Option (on page 152) 
 

Overview Menu Option 

NOTE:  Since HP Power Manager uses a flash player, this screen 
displays differently if you are browsing to the Management Server from 
an HP-UX client browser. Currently there is not a HP-UX flash player 
available. If you are browsing from a Windows or Linux client browser, 
all pages appear with full flash support. 

Click Overview in the left navigation frame to display the Overview screen. This 
screen displays overall views of the UPS status and contains the following tabs: 
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• Meter Display 

• UPS Animation 

• Alarms (x) 

NOTE:  The variable x indicates the number of active alarms. For 
example, Alarms (2) means that the UPS has two active alarms. 

 

Meter Display Tab 

NOTE:  Depending on the specific UPS model, this screen might vary. 
The screen shown is only an example. 

 

Under the Meter Display tab, the status of the UPS is shown in graphical and text 
format. Input Voltage, Output Voltage, and Output Load information is displayed 
graphically on the left side of the screen, with the color on the meter representing 
the current state of the UPS. 
                

Color Device Status 

Green Normal 

Yellow Warning 
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Color Device Status 

Red Critical 

 

Battery, Input, and Output parameters are listed as text on the right side of the 
screen. A status icon indicates the current state of each parameter. 
                

Icon Parameter Status 

 
Normal 

 
Warning 

 
Critical 

 
 

UPS Animation Tab 

The UPS Animation tab provides an animated view of the flow of power into and 
out of the UPS. Battery, Input, and Output parameters are listed as text on the 
right side of the screen. A status icon next to each parameter indicates the current 
state of the parameter (Normal, Warning, or Critical). 
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The animation graphic changes based on the current UPS status. The following 
screenshot is an example of the UPS On Utility power. 

 

If the UPS goes into Battery, Bypass, Buck, or Boost mode, the graphic on the 
left side of the screen changes to one of the following animations. 
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NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 
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Alarms Tab 

The Alarms (x) tab displays a list of active alarms for the UPS, where x is the 
current number of active alarms. Click an alarm to see a description of the alarm. 
If there are no active alarms, the screen indicates No Active Alarms. A status 
icon next to each alarm indicates the severity of the alarm (Warning or Critical). 
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Alarms Menu Option 

Click Alarms in the left navigation frame to display the Alarms screen. This 
screen lists all possible alarms (active and normal) specific for each UPS model. 
The active alarms are listed at the top of the screen with the date and time at 
which the alarm most recently occurred. Click an active alarm to see a 
description of the alarm. A status icon next to each alarm indicates the current 
state of the alarm (Normal, Warning, or Critical). 

 
 

Identification Menu Option 

Click Identification in the left navigation frame to display the Identification 
screen. This screen displays specific device and contact information. 

NOTE:  Depending on the specific UPS model, this screen might vary. 
The screen shown is only an example. 
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You can enter or change the contact information and device name on the Settings 
screen. For more information, refer to "Settings Menu Option (on page 152)." 
Only users with administrator rights can enter this information. 

 
 

Parameters Menu Option 

Click Parameters in the left navigation frame to display the UPS Parameters 
screen. This screen displays the available UPS parameter values. A status icon 
next to each parameter indicates the current state of the parameter (Normal, 
Warning, or Critical). 
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NOTE:  Depending on the specific UPS model, this screen might vary. 
The screen shown is only an example. 

 
 

Battery Self-Test Results Summary 

• In Progress—The battery self-test is in progress. 

• Passed—The battery self-test has completed successfully. 

• Test Aborted—The battery self-test was not performed at this time because 
of one of the following: 

– The UPS is already On Battery. 

– The battery is not presently charged. 



126  HP Power Manager 4.0 User Guide 
 

 

– In some implementations, the battery self-test is scheduled and begins 
when the batteries are fully charged. 

• Test Failed—A bad battery is detected, or the battery self-test failed. 

• Test Scheduled—The battery self-test was not performed at this time but 
will be performed when the system has the proper conditions. 

• Battery Disconnect—All batteries have been disconnected. 

• Battery Not Installed—No batteries were connected to the system at last 
power up. 

• Unknown—Unable to determine the status of the last test. 

NOTE:  Battery self-test results are cleared after the UPS is reset. 
 

Attached Devices Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click Attached Devices in the left navigation frame to display the Attached 
Devices screen. 
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NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 
              

Icon Status 

 
Agent is communicating with the Management Server, and the 
versions are compatible. 

 
Agent version is not compatible. Upgrade agent. 

 
Agent is not communicating with the Management Server. For more 
information, refer to "Red Status Icon Displays." 

 

This screen enables you to: 

• View attached devices and load segment power status 

• Control load segments ("Controlling a Load Segment" on page 128) (turn 
off, on, or cycle power) 
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• Add ("Adding an Attached Device" on page 128) or delete attached devices 
("Editing or Deleting an Attached Device" on page 131) 

• Edit an attached device ("Editing or Deleting an Attached Device" on page 
131) 

The estimated UPS runtime appears at the top of the screen. The total time 
required to shut down the entire UPS is recalculated when attached devices are 
added, deleted, or modified. This time is determined by totaling the time required 
to shut down each device on the UPS. 
 

Controlling a Load Segment 

To control a load segment, perform one of the following: 

• Click Off to shut down a load segment, which allows for the graceful 
shutdown of attached devices. 

• Click On to turn on a load segment. 

• Click Cycle to gracefully shut down and turn on a load segment. 

NOTE:  Off and On are not available for the load segment to which the 
Management Server is attached. 

 

Adding an Attached Device 

1. Click Add New Device on the Attached Devices screen. The Add Device 
screen appears. 
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NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 

2. Enter the device name or description in the Device Description field. 

3. Select the type of device in the Device Type dropdown box: 

– Remote Agent—Select Remote Agent when attaching a HPPM Remote 
Agent to a UPS load segment. 

– Storage Device—Select Storage Device when attaching a shared hard 
disk storage device to a UPS load segment. Storage devices have the 
longest runtime so servers accessing this device can save data before 
shutting down. 

– Other Device—Select Other Device for any unmanaged device, such as a 
router or hub. Unmanaged devices are either on or off and are not shut 
down gracefully. 

4. If output power is supplied by controllable load segments, select the load 
segments to which the device is attached in the Load Segment dropdown 
box. 

5. If the device type is Remote Agent, enter the host name or IP address in the 
Host Name or IP Address field. 

6. Enter the estimated time required to shut down the server in the Shut Down 
OS field. 

7. To configure the command procedure SDScript to run at shut down: 

a. Select Run Command Procedure (SDScript)? at shutdown. 
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b. Edit the SDScript file or create a new SDScript file. A sample SDScript 
file is landed in the root folder for every Management Server and 
Remote Agent. The name of the SDScript file must be SDScript.CMD, 
and this file must remain in the root folder. 

IMPORTANT:  SDScript command execution can be a very powerful 
tool and should be tested thoroughly before being used for the first time 
in response to a power event. Not all programs and applications are 
suitable to be executed as a process, especially programs that do not 
create their own environments. Command execution behavior varies by 
operating system, and, in general, commands to be executed should be 
put into a batch file or shell script depending on the operating system 
that will be executing the commands. Using an SDScript gives you more 
control over the circumstances in which commands are executed and 
allows the commands to run in a copy of the environment. 

When selecting commands to be executed in the SDScript file, choose 
programs and processes that do not require user input or interaction. 
Since the commands can be executed at any time, it is difficult to predict 
if a user will be available to interact with any programs that are 
launched. Verify that specified drive mappings, user specific directories, 
and programs that require special rights are accessible by the SDScript 
file. 

Most operating systems have a method for spawning new processes. In 
Windows operating systems, commands can be preceded with START, 
and in most Linux/Unix systems, sh can be used. When designing your 
SDScript file, determine which commands require a separate process 
and which commands can be run one after another in the same 
process. Refer to the documentation that came with your operating 
system for more information on batch files or script files. 

NOTE:  HP Power Manager cannot run an SDScript on a server unless 
the server has a Remote Agent installed. The SDScript file that will be 
run must reside on the server on which the command will be executed. 

NOTE:  HP Power Manager shuts down the operating system 
gracefully. Use the SDScript file for other tasks, such as backing up files 
to tape or shutting down a database. 

c. Enter the estimated time required to complete the procedure in the 
Execute Command field. 

8. Click Save Changes to save the information. 
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The newly added device displays under the specific load segment. The status 
icon in front of the device link indicates the attached device agent is 
communicating with the Management Server, and the versions are 
compatible. For a detailed description of the agent status, refer to "System 
Tray Icon (on page 110)." 

 

Editing or Deleting an Attached Device 

1. Click the link for the device you want to edit or delete on the Attached 
Devices screen. 

The Edit/Delete Device screen appears. 

 

2. Edit the device name or description in the Device Description field. 

3. If the device is not a Management Server, select the type of device in the 
Device Type dropdown box: 

– Remote Agent—Select Remote Agent when attaching a HPPM Remote 
Agent to a UPS load segment. 

– Storage Device—Select Storage Device when attaching a shared hard 
disk storage device to a UPS load segment. Storage devices have the 
longest runtime so servers accessing this device can save data before 
shutting down. 

– Other Device—Select Other Device for any unmanaged device, such as a 
router or hub. Unmanaged devices are either on or off and are not shut 
down gracefully. 



132  HP Power Manager 4.0 User Guide 
 

 

4. If output power is supplied by controllable load segments, select the load 
segment to which the device is attached in the Load Segment dropdown box. 

5. If the device type is Remote Agent, enter the host name or IP address in the 
Host Name or IP Address field. 

6. If the device type is Remote Agent or Management Server, enter the 
estimated time required to shut down the server in the Shut Down OS field. 

7. To configure the command procedure SDScript to run at shut down: 

a. Select Run Command Procedure (SDScript)? at shutdown. 

b. Edit the SDScript file or create a new SDScript file. A sample SDScript 
file is landed in the root folder for every Management Server and 
Remote Agent. The name of the SDScript file must be SDScript.CMD, 
and this file must remain in the root folder. 

IMPORTANT:  SDScript command execution can be a very powerful 
tool and should be tested thoroughly before being used for the first time 
in response to a power event. Not all programs and applications are 
suitable to be executed as a process, especially programs that do not 
create their own environments. Command execution behavior varies by 
operating system, and, in general, commands to be executed should be 
put into a batch file or shell script depending on the operating system 
that will be executing the commands. Using an SDScript gives you more 
control over the circumstances in which commands are executed and 
allows the commands to run in a copy of the environment. 

When selecting commands to be executed in the SDScript file, choose 
programs and processes that do not require user input or interaction. 
Since the commands can be executed at any time, it is difficult to predict 
if a user will be available to interact with any programs that are 
launched. Verify that specified drive mappings, user specific directories, 
and programs that require special rights are accessible by the SDScript 
file. 

Most operating systems have a method for spawning new processes. In 
Windows operating systems, commands can be preceded with START, 
and in most Linux/Unix systems, sh can be used. When designing your 
SDScript file, determine which commands require a separate process 
and which commands can be run one after another in the same 
process. Refer to the documentation that came with your operating 
system for more information on batch files or script files. 

NOTE:  HP Power Manager cannot run an SDScript on a server unless 
the server has a Remote Agent installed. The SDScript file that will be 
run must reside on the server on which the command will be executed. 



 Configuration and Operation 133 
 

 

NOTE:  HP Power Manager shuts down the operating system 
gracefully. Use the SDScript file for other tasks, such as backing up files 
to tape or shutting down a database. 

c. Enter the estimated time required to complete the procedure in the 
Execute Command field. 

8. Click Save Changes to save the information, or click Delete Device to delete 
the device. 

The device displays under the specific load segment, and any changes that 
have been made are reflected on the Attached Devices screen. The status icon 
in front of the device link indicates the attached device agent is 
communicating with the Management Server, and the versions are 
compatible. For detailed descriptions of the agent status, refer to "System 
Tray Icon (on page 110)." 

NOTE:  The Delete Device button only displays for devices other than 
the Management Server. 

NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 

Power Fail Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click Power Fail in the left navigation frame to display the Power Fail Settings 
screen. This screen enables you to configure how the Management Server should 
shut down attached devices in the event of a power failure. 
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NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 
 

Configuring the Shutdown Delay for the Management Server Load Segment 

1. Click the Management Server link in the Attached Devices column to edit 
the Management Server information on the Edit/Delete Device screen 
("Editing or Deleting an Attached Device" on page 131).  

IMPORTANT:  The Management Server is defaulted to load segment 1. 
Verify the Management Server load segment, and edit the device if 
necessary.  

2. Configure the shutdown settings for the Management Server using one of the 
three options in the Shutdown Settings column.  
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– Conserve Battery Power—Select the radio button in the Shutdown Delay 
column, and enter the number of minutes after power fails that HPPM 
should wait before starting to shut down the Management Server load 
segment. The total time needed to gracefully shut down the Management 
Server is equal to the shutdown delay plus the number of minutes 
required to shutdown the Management Server operating system. The 
number of minutes required to shutdown the Management Server can be 
updated on the Edit/Delete Device screen ("Editing or Deleting an 
Attached Device" on page 131) by clicking the Required OS Shutdown 
Time (After Delay) link. 

NOTE:  The shutdown delay for the Management Server load segment 
must be as long as or longer than the shutdown delay for all other load 
segments. 

– Maximize Runtime—Select the radio button in the Run Until Battery 
Depletion column to maximize UPS runtime. HPPM initiates load 
segment shutdown when the UPS issues a low battery alarm. 

 CAUTION:  Selecting this option might result in an ungraceful 
shutdown. The amount of remaining runtime cannot be accurately 
predicted after a low battery warning is issued. 

– Advanced—Select the radio button in the Advanced column, and click the 
Settings button to configure advanced power fail settings ("Configuring 
Advanced Power Fail Settings" on page 136). 

3. Enter the amount of time HPPM should wait before restarting the 
Management Server in the Restart Settings column. This option allows utility 
power to stabilize and disks in shared storage configurations to spin up 
before the server restarts. 

4. Click Refresh Page to cancel changes and restore the page settings to the 
last saved configuration. 

5. Click Save Changes to save the information. 

6. Click Power Fail in the left navigation frame to view saved settings. 
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Configuring Advanced Power Fail Settings 

1. Click the Settings button in the Advanced section of the Power Fail Settings 
screen ("Power Fail Menu Option" on page 133) to display the Advanced 
Power Fail Settings screen.  

 

2. Select one radio button in the On Battery Shutdown field and one radio 
button in the Low Battery Shutdown field. The following matrix describes 
the possible combinations. 

                 

 Low Battery Shutdown 

Begin shutdown after a delay 
selected 

Low Battery Shutdown  

Do not automatically shutdown 
selected 
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 Low Battery Shutdown 

Begin shutdown after a delay 
selected 

Low Battery Shutdown  

Do not automatically shutdown 
selected 

On Battery Shutdown 

Begin shutdown after a 
delay selected 

HPPM initiates system shutdowns 
after the specified delay when the 
UPS begins to operate on battery 
power, unless the UPS issues a 
low battery alarm before the 
shutdowns are initiated. If a low 
battery alarm occurs during the 
delay countdown, HPPM ignores 
the on battery settings and 
observes the low battery shutdown 
delay setting. 

HPPM initiates system shutdowns 
after the specified delay when the 
UPS begins to operate on battery 
power. If a low battery alarm occurs 
during the delay countdown, HPPM 
ignores the low battery alarm and 
continues to observe the on battery 
shutdown delay setting.¹ 

On Battery Shutdown 

Shutdown based on UPS 
reported runtime 
remaining selected 

HPPM initiates system shutdowns 
when the UPS runtime reaches 
zero, unless the UPS issues a low 
battery alarm before the 
shutdowns are initiated. If a low 
battery alarm occurs during the 
runtime countdown, HPPM ignores 
the runtime remaining and 
observes the low battery shutdown 
delay setting. 

HPPM initiates system shutdowns 
when the UPS runtime reaches 
zero. If a low battery alarm occurs 
during the runtime countdown, 
HPPM ignores the low battery alarm 
and continues to observe the 
runtime countdown.¹ 

On Battery Shutdown 

Do not automatically 
shutdown selected 

HPPM initiates system shutdowns 
when the UPS issues a low battery 
alarm. HPPM observes the low 
battery shutdown delay setting. 

HPPM does not initiate any type of 
system shutdown. Power is 
maintained until the battery is 
depleted.² 

 

¹  CAUTION:  Selecting this option might result in an ungraceful shutdown. The 
amount of remaining runtime cannot be accurately predicted after a low battery warning is 
issued. 

²  CAUTION:  Running batteries to depletion can cause an ungraceful shutdown if 
a second power failure occurs before the batteries have fully charged. 

3. Click Save Changes to save the advanced settings. The Power Fail Settings 
screen displays. 

4. Click Save Changes on the Power Fail Settings screen to apply the saved 
advanced settings. 
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Configuring Shutdown for All Other Load Segments 

1. Click the device link in the Attached Devices column to edit the device 
information on the Edit/Delete Device screen ("Editing or Deleting an 
Attached Device" on page 131). 

2. Configure the Shutdown Settings for each device using one of the two 
options in the Shutdown Settings column.  

– Shed Load—Use the Shed Load option to prioritize load segment 
shutdown. Select the radio button in the Shutdown Delay column, and 
enter the number of minutes after power fails that HPPM should wait 
before starting to shut down the load segment. Enter a shorter delay for 
load segments that power less critical equipment to preserve UPS battery 
power for other load segments. The total time needed to gracefully shut 
down the load segment is equal to the shutdown delay plus the number of 
minutes required to shut down the operating system. The number of 
minutes required to shut down the operating system can be updated on the 
Edit/Delete Device screen ("Editing or Deleting an Attached Device" on 
page 131) by clicking the Required OS Shutdown Time (After Delay) 
link. 

NOTE:  A load segment that has a storage device attached shuts down 
with the Management Server. The Shed Load option is not available for 
this load segment. 

– Maximize Runtime—Select the radio button in the Shutdown With 
Management Server column to maximize UPS runtime. HPPM initiates 
load segment shutdown at the time the Management Server shuts down. 

3. Enter the amount of time to wait before restarting the attached device in the 
Restart Settings column. This option allows utility power to stabilize and 
disks in shared storage configurations to spin up before the server restarts. 

4. Click Refresh Page to cancel changes and restore the page settings to the 
last saved configuration. 

5. Click Save Changes to save the information. 

6. Click Power Fail in the left navigation frame to view saved settings. 
 

Shutdown Events Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 
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Click Shutdown Events in the left navigation frame to display the Shutdown 
Events screen. In addition to the typical events (such as power fail events) 
causing shutdowns, this screen enables you to configure other events for 
shutdown. 

When a shutdown event occurs, HPPM gracefully shuts down all attached 
devices and UPS load segments. 

To specify an event for shutdown: 

1. Select Shutdown? for the event. 

2. Enter the number of minutes to wait between the time the event occurs and 
the time the device shuts down in the Delay (Minutes) field. 

3. Click Save Changes to save the information. 
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NOTE:  Depending on the specific UPS model, this screen might vary. 
The screen shown is only an example. 

 

NOTE:  If the event clears before the delay time has expired, the 
shutdown is not executed. 

 

Scheduled Shutdown Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 
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Click Scheduled Shutdown in the left navigation frame to display the Scheduled 
Shutdown screen. 

 

This screen enables you to: 

• View a summary of the set times at which the entire UPS shuts down and 
restarts 

• Schedule a one-time shutdown ("Configuring a One-Time Scheduled 
Shutdown Event" on page 141) 

• Schedule a daily shutdown ("Configuring a Daily Scheduled Shutdown 
Event" on page 142) 

• Schedule a weekly shutdown ("Configuring a Weekly Scheduled Shutdown 
Event" on page 142) 

• Delete a scheduled shutdown ("Deleting a Scheduled Shutdown Event" on 
page 143) 

 

Configuring a One-Time Scheduled Shutdown Event 

1. Click Add New Scheduled Shutdown on the Scheduled Shutdown screen. 

The Scheduled Shutdown screen appears. 

2. In the Frequency field, select the One Time radio button to schedule a single 
shutdown event. 

3. Enter the shutdown date and time in the Shutdown field. 

4. Enter the restart date and time in the Restart field. 
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5. Click Add. 

 
 

Configuring a Daily Scheduled Shutdown Event 

1. Click Add New Scheduled Shutdown on the Scheduled Shutdown screen. 

The Scheduled Shutdown screen appears. 

2. In the Frequency field, select the Daily radio button to schedule a daily 
shutdown event. 

3. Enter the shutdown time in the Shutdown field. 

4. Enter the restart day and time in the Restart field. 

5. Click Add. 

 
 

Configuring a Weekly Scheduled Shutdown Event 

1. Click Add New Scheduled Shutdown on the Scheduled Shutdown screen. 

The Scheduled Shutdown screen appears. 

2. In the Frequency field, select the Weekly radio button to schedule a weekly 
shutdown event. 

3. Enter the shutdown day and time in the Shutdown field. 

4. Enter the restart day and time in the Restart field. 
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5. Click Add. 

 
 

Deleting a Scheduled Shutdown Event 

1. Select the checkbox in the Delete column of the Scheduled Shutdown screen 
for the shutdown event you want to delete. 

2. Click Delete Selection(s). 
 

Event Settings Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click Event Settings in the left navigation frame. The screen that appears 
contains the Event Notifications and Event Categories tables. 
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The Event Notifications table enables you to define the event notifications 
(EMail, SNMP, or Broadcast) the software takes for each event by category 
(Critical, Warning, Information, User Defined 1, or User Defined 2). 

NOTE:  You must define the severity of each event according to your 
environment. 

The Event Categories table enables you to create up to two additional event 
categories, which can be used to define the event notifications. The added 
categories are displayed as column headings on the Event Notifications table and 
event Severities screen. 
 

Creating User-Defined Event Categories 

Creating user-defined categories enables you to categorize alarms so that specific 
alerts are sent to certain groups of people. To create a user-defined event 
category: 

1. In the Event Categories table on the main screen, enter the name of the new 
category in the Name field. 

2. Select the SNMP severity level of the new category in the Severity dropdown 
box. 

3. Click Save Changes to save the added information. The added category 
appears as a column heading on the Event Notification table and Event 
Severities screen. 

 
 

Categorizing Individual Events by Severity 

To designate a category for an event: 
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1. In the Event Notification table on the main screen, click any of the category 
column heading links (Critical, Warning, Information, User Defined 1, or 
User Defined 2). 

 

The Event Severities screen appears with the events listed in the Event 
column. 

2. Select the radio button for the category into which each event should be 
placed. 

3. Click Save Changes to save the information. 
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Selecting Notification Actions for Events by Category 

You can specify an event notification by clicking one of the event notification 
links (EMail, SNMP, or Broadcast) on the left side of the Event Notifications 
table on the main screen. 
 

Setting Up E-Mail Notifications 

1. Click the EMail link on the Event Notifications table in the main screen. 

The EMail Setup screen appears. 

2. Enter the mail server IP address or host name in the SMTP Server field. 

3. Enter the e-mail address that HPPM marks messages as being sent from in 
the SMTP From Address field. 

4. Select the Enabled checkbox to indicate that e-mail notifications are sent for 
events in each category (Critical, Warning, Information, User Defined 1, and 
User Defined 2). 

5. Enter up to six e-mail addresses in the EMail Address(es) field for the 
persons who should receive e-mail notifications of events that occur in each 
category. 

6. Enter the amount of time to delay before the e-mail is sent in the Delay 
(seconds) field. 

NOTE:  If the event clears before the delay time has expired, then the 
event notification is not sent. 

7. Click Save Changes to save the information. 
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8. Click Send Test Message to send a test e-mail. 

 
 

Setting Up SNMP Trap Notifications 

1. Click the SNMP link on the Event Notifications table in the main screen. 

The SNMP Setup screen appears. 

2. Enter the SNMP trap community string in the Trap Community String field 
(public is the default string). 

3. Select the Enabled checkbox to indicate that SNMP trap notifications are 
sent for events in each category (Critical, Warning, Information, User 
Defined 1, and User Defined 2). 
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4. Enter up to six trap recipients in the SNMP Address(es) field for the 
computers that receive SNMP trap notifications of events that occur in each 
category. 

5. Enter the amount of time to delay before the trap is sent in the Delay 
(seconds) field. 

NOTE:  If the event clears before the delay time has expired, then the 
event notification is not sent. 

6. Click Save Changes to save the information. 

7. Click Send Test Message to send a test SNMP trap. 

For more information on using SNMP to send traps to Insight Manager 7 SP2, 
refer to "Configuring HPPM with Insight Manager 7 SP2 (on page 193)." 
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Setting Up Broadcasts 

1. Click the Broadcast link on the Event Notifications table in the main screen. 

The Broadcast Setup screen appears. 

2. Select the Enabled checkbox to indicate that broadcast notifications are sent 
for events in each category (Critical, Warning, Information, User Defined 1, 
and User Defined 2). 

3. Enter up to six broadcast recipients in the Broadcast Address(es) field for the 
persons who should receive broadcast notifications of events that occur in 
each category. The broadcast recipient can be an IP address, user name, 
computer name, or messaging name. 

NOTE:  If the recipient is a computer name that contains spaces, the 
name must be enclosed in quotation marks. 

4. Enter the amount of time to delay before the broadcast is sent in the Delay 
(seconds) field. 

NOTE:  If the event clears before the delay time has expired, then the 
event notification is not sent. 

5. Click Save Changes to save the information. 

6. Click Send Test Message to send a test broadcast. 

IMPORTANT:  Any computer running Windows® and sending or 
receiving broadcasts must have the Messenger service enabled. The 
Messenger service can be accessed from the Services option in the 
Administrative Tools section of the Control Panel. The Messenger 
service is turned off by default in Windows® Server 2003. 

IMPORTANT:  Any computer running Linux that is sending or receiving 
broadcasts must have the Samba packages installed, configured, and 
running. If the computer running Linux is to receive broadcasts, Samba 
must be set to display the received message by adding a message 
command statement to the Global Settings section of the SMB.CONF 
file, such as the following: 

message command = /bin/csh -c 'cat %s | wall; rm %s' 
& 
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This statement sets Samba to route the broadcast message to the wall 
command, which displays the message on the system (either in a 
terminal window, at the console, or in a pop-up message, depending on 
the display environment), then deletes the message. The Samba 
processes must be restarted after editing the SMB.CONF file to enable 
the changes. For more information, refer to the Samba documentation 
on the Samba website (http://www.samba.org). 

In addition, for a Linux Management Server to send broadcast to either 
Windows® or Linux systems (or both), entries must be added to the 
/etc/hosts file on the Management Server for each host name to which it 
broadcasts. 

For example, to broadcast from a Linux Management Server to a 
Windows® workstation named "george" at IP address 143.85.41.121, 
add the following to the hosts file:  143.85.41.121   george 

 
 

Manual Control Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

http://www.samba.org/
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Click Manual Control in the left navigation frame. The screen that displays 
contains the Select Command and Execute Command boxes. These boxes enable 
you to select and execute UPS commands manually. 

NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 
 

Executing the Battery Test Command 

1. Select Battery Test in the Select Command box. 

The Execute Battery Test box appears. 

2. Enter the amount of time that the device runs on battery while running the 
test in the Duration In Seconds field. HP recommends that you do not set this 
to exceed 30 seconds.  

 CAUTION:  Selecting this option might result in an ungraceful 
shutdown. 
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3. Click Execute Command to execute the control command and start the test. 
The results of the test display on the UPS Parameters screen in the Test 
Results Summary field, and a log entry is created in the Applications Log. 
For more information on this screen, refer to "Parameters Menu Option (on 
page 124)." 

IMPORTANT:  Do not run a battery test while the UPS is On Battery. 

NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 
 

Settings Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click the Settings menu option in the left navigation frame to display the 
Settings screen. This screen enables you to enter contact information (such as 
name, e-mail, and phone number) and values for settable UPS parameters. The 
information entered on this screen appears on the Identifications and UPS 
Parameters screens. For more information, refer to "Identification Menu Option 
(on page 123)" and "Parameters Menu Option (on page 124)." 

To enter contact information and UPS settings: 

1. Enter or select the date on which the battery was installed in the Battery 
Installed Date field. 

2. Enter the name of the contact person in the Contact field. 

3. Enter the e-mail address of the contact person in the Contact Email field. 

4. Enter the phone number of the contact person in the Contact Phone field. 

5. Enter the name of the UPS in the Device Name field. 
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6. Click Save Changes to save the information. 
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Data Logs 

In this section 

Logs Tab.....................................................................................................................................155
 
 

Logs Tab 

Menu options listed under the Logs tab include: 

• UPS Summary Menu Option (on page 155) 

• UPS Detailed Menu Option (on page 157) 

• UPS Data Menu Option (on page 159) 

• UPS Data Graph Menu Option (on page 162) 

• Application Menu Option (on page 163) 
 

UPS Summary Menu Option 

NOTE:  Since HP Power Manager uses a flash player, this screen 
displays differently if you are browsing to the Management Server from 
an HP-UX client browser. Currently there is not a HP-UX flash player 
available. If you are browsing from a Windows or Linux client browser, 
all pages appear with full flash support. 
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Click UPS Summary in the left navigation frame to display the UPS Summary 
screen. This screen displays a graphical view of the events that have occurred on 
the UPS for a selected period. A status icon on the left side of the each event 
indicates the current state of the event (Warning or Critical). The number on the 
right side indicates the number of times the alarm has been reported during the 
period (for example, the Battery Low alarm has occurred 10 times in the last 24 
hours). 

 

To change the period displayed, click one of the following buttons: 

• Last 24 Hours 

• Last Week 

• Last Month 

• Last Year 

NOTE:  The period ends the moment you click the button. For example, 
if you click Last 24 Hours, the software counts back 24 hours from the 
time you clicked the button and displays the events that occurred during 
that time period. 
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Click an event name to display more information about the selected event and 
recommended actions to take. 
 

UPS Detailed Menu Option 

Click UPS Detailed in the left navigation frame to display the UPS Detailed 
screen. This screen displays a log of the events that have occurred on the UPS, 
such as the UPS switching to battery power. The following information is 
displayed for each event: 

• Severity—An icon indicating the severity or status of the alarm (Critical, 
Warning, Information, or Cleared) 

• Description—The name of the event (click the event name to display more 
information, such as a detailed description and recommended actions to take) 

• Date—The date at which the event occurred 

• Time—The time at which the event occurred 

NOTE:  The log can be sorted by clicking any of the column headings. 

On the UPS Detailed screen: 

• Click Clear Logs to clear the log files. 

• Click Refresh Page to update the screen with current log information. 

• Click Export Logs to export the event log ("Exporting a UPS Event Log" on 
page 158). 

To navigate through the log entries: 

• Click First to go to the first entry in the log. 

• Click << to scroll to the previous page in the log. 

• Click < to scroll to the previous entry in the log. 

• Click > to scroll to the next entry in the log. 

• Click >> to scroll to the next page in the log. 
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• Click Last to go to the last entry in the log. 

 
 

Exporting a UPS Event Log 

1. Click Export Logs at the bottom of the UPS Detailed screen. 

The Event Log Export screen appears. 

2. Enter the date range of the data in the Export data from and to fields. 

3. Select Comma-Separated or Tab Delimited. 

4. Do one of the following: 

– To save the file to the Management Server, select Save to File, and enter 
the name of the file. The file is saved in the HPPM Install folder. This file 
is overwritten every time a log file is saved with the same name. To save 
multiple log files, use a different name for each file. 

– To download the document to a specified location, select Download 
Document. 
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5. Click Do Export to export the file, or click Cancel to cancel the operation. 

 

HPPM exports Japanese logs into two different file types. Refer to the following 
table to determine the file type for your operating system.  
          

Operating System Saved File Type Downloaded File 
Type 

Red Hat Linux EUC-JP UTF-8 

SUSE Linux EUC-JP UTF-8 

HP-UX EUC-JP UTF-8 

Windows UTF-8 UTF-8 

 
 

UPS Data Menu Option 

Click UPS Data in the left navigation frame to display the UPS Data screen. This 
screen displays a log of all UPS data that has been recorded, such as Input 
Voltage, Temperature, and Battery Capacity. 

• Click Log Settings to change the logging interval. 

• Click Clear Logs to clear the log files. 

• Click Refresh Page to update the screen with current log information. 

• Click Export Logs to export the data log ("Exporting a UPS Data Log" on 
page 161). 
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To navigate through the log entries: 

• Click First to go to the first entry in the log. 

• Click << to scroll to the previous page in the log. 

• Click < to scroll to the previous entry in the log. 

• Click > to scroll to the next entry in the log. 

• Click >> to scroll to the next page in the log. 

• Click Last to go to the last entry in the log. 

NOTE:  Depending on the specific UPS model, some features might not 
be supported. The screen shown is only an example. 

 
 

Changing UPS Data Log Settings 

1. Click Log Setting at the bottom of the UPS Data screen. 

The Log Settings screen appears. 

NOTE:  Only users with administrative rights can edit the information on 
this screen. 

2. Select the log interval in minutes using the dropdown box in the Log interval 
row. The lower the log interval, the more frequently disk space is used. 

3. Select the checkbox for each parameter you want to display in the log. 
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4. Click Save Changes to save the changes. 

 
 

Exporting a UPS Data Log 

1. Click Export Logs at the top of the UPS Logs screen. 

The Data Log Export screen appears. 

2. Enter the date range of the data in the Export data from and to fields. 

3. Select Comma-Separated or Tab Delimited. 

4. Do one of the following: 

– To save the file to the Management Server, select Save to File, and enter 
the name of the file. The file is saved in the HPPM Install folder. This file 
is overwritten every time a log file is saved with the same name. To save 
multiple log files, use a different name for each file. 

– To download the document to a specified location, select Download 
Document. 
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5. Click Do Export to export the file, or click Cancel to cancel the operation. 

 

HPPM exports Japanese logs into two different file types. Refer to the following 
table to determine the file type for your operating system.  
          

Operating System Saved File Type Downloaded File 
Type 

Red Hat Linux EUC-JP UTF-8 

SUSE Linux EUC-JP UTF-8 

HP-UX EUC-JP UTF-8 

Windows UTF-8 UTF-8 

 
 

UPS Data Graph Menu Option 

NOTE:  Since HP Power Manager uses a flash player, this screen 
displays differently if you are browsing to the Management Server from 
an HP-UX client browser. Currently there is not a HP-UX flash player 
available. If you are browsing from a Windows or Linux client browser, 
all pages appear with full flash support. 

Click UPS Data Graph in the left navigation frame to display the UPS Data 
Graph screen. This screen enables you to create line graphs of logged numerical 
UPS data. To create a graph: 

1. Select the parameter you want to graph in the first dropdown box. 

2. Select the amount of data you want to graph in the second dropdown box, 
starting with the present and going back in time. 
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3. Click Get Data. The graph appears. 

To adjust the Y axis of the graph: 

1. Enter the appropriate values in the Ymin and Ymax fields. 

2. Click Redraw. 

 
 

Application Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click Application in the left navigation frame to display the Application Logs 
screen. This screen displays a log of all application events that have occurred, 
such as a user logging in. The following information is displayed for each 
application event: 

• User—The login name of the user who performed the action 

• Description—A description of the application event 
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• Date—The date at which the event occurred 

• Time—The time at which the event occurred 

NOTE:  The log can be sorted by clicking any of the column headings. 

On the Application Logs screen: 

• Click Clear Logs to clear the log files. 

• Click Refresh Page to update the screen with current log information. 

• Click Export Logs to export the application log ("Exporting an Application 
Log" on page 165). 

To navigate through the log entries: 

• Click First to go to the first entry in the log. 

• Click << to scroll to the previous page in the log. 

• Click < to scroll to the previous entry in the log. 

• Click > to scroll to the next entry in the log. 

• Click >> to scroll to the next page in the log. 

• Click Last to go to the last entry in the log. 
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Exporting an Application Log 

1. Click Export Logs at the bottom of the Application Logs screen. 

The Application Log Export screen appears. 

2. Enter the date range of the data in the Export data from and to fields. 

3. Select Comma-Separated or Tab Delimited. 

4. Do one of the following: 

– To save the file to the Management Server, select Save to File, and enter 
the name of the file. The file is saved in the HPPM Install folder. This file 
is overwritten every time a log file is saved with the same name. To save 
multiple log files, use a different name for each file. 

– To download the document to a specified location, select Download 
Document. 

5. Click Do Export to export the file, or click Cancel to cancel the operation. 

 

HPPM exports Japanese logs into two different file types. Refer to the following 
table to determine the file type for your operating system.  
          

Operating System Saved File Type Downloaded File 
Type 

Red Hat Linux EUC-JP UTF-8 

SUSE Linux EUC-JP UTF-8 

HP-UX EUC-JP UTF-8 
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Operating System Saved File Type Downloaded File 
Type 

Windows UTF-8 UTF-8 
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Account Setup and Help 

In this section 

Setup Tab....................................................................................................................................167
Help Tab .....................................................................................................................................169

 
 

Setup Tab 

Menu options listed under the Setup tab include: 

• My Account Menu Option (on page 167) 

• User Accounts Menu Option (on page 168) 
 

My Account Menu Option 

Click My Account in the left navigation frame to display the My Account 
screen. This screen enables you to change your login password. 

To change your password: 

1. Enter the new password in the Password field. 

2. Enter the new password again in the Verify Password field. 

3. Click Save Changes to save the new password. 
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User Accounts Menu Option 

NOTE:  The link to this screen does not appear if you do not have 
administrative rights. 

Click User Accounts in the left navigation frame to access the User Accounts 
screen. This screen enables administrators to manage user accounts. 

 
 

Adding a User Account 

1. Enter the user's login name in the Name field. 

2. Enter the user's password in the Password field. 

3. Enter the user's password again in the Verify Password field. 

4. If the new user is given administrator rights, select the Administrator 
checkbox. 

5. Click Save Changes to save the new user account information. 
 

Modifying a User Account 

If you have administrator rights, you can change a user's login name or password. 
You can also add or remove administrator rights to the user's account. 

Changing a User Login Name 
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1. Enter the changed name in the Name field. 

2. Enter the user's password in the Password field. 

3. Enter the password again in the Verify Password field. 

4. If the user has administrator rights added or removed, select or deselect the 
Administrator checkbox. 

5. Click Save Changes to save the updated user account information. 

Changing a User Password 

1. Enter the user's login name in the Name field. 

2. Change the password: 

a. Enter the new password in the Password field. 

b. Enter the new password again in the Verify Password field. 

3. If the user has administrator rights added or removed, select or deselect the 
Administrator checkbox. 

4. Click Save Changes to save the updated user account information. 
 

Deleting a User Account 

1. Select the Delete checkbox for the user account that is to be removed. 

2. Click Delete Selected Users to delete the user account. The account is 
removed and no longer appears on the User Accounts screen. 

 

Help Tab 

Menu options listed under the Help tab include: 

• About Menu Option (on page 170) 

• Contents Menu Option (on page 171) 

• Info & Updates Menu Option (on page 173) 
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About Menu Option 

Click About in the left navigation frame to display the About HP Power 
Manager screen. This screen displays information about the company and 
product. 

The screen contains a link to the HP Power Products page 
(http://www.hp.com/products/ups), as well as the following hyperlinked logos: 

• HP Invent (http://www.hp.com) 

• Macromedia Shockwave/Flash (http://www.macromedia.com) 

• GoAhead (http://www.goahead.com) 

 
 

http://www.hp.com/products/ups
http://www.hp.com/
http://www.macromedia.com/
http://www.goahead.com/
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Contents Menu Option 

Click Contents in the left navigation frame to display the Contents screen. This 
screen provides a list of the links to help topics. 
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Info & Updates Menu Option 

Click Info & Updates in the left navigation frame to access the Info & Updates 
screen. This screen displays UPS information, online registration, and links to 
HP. 
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Troubleshooting 
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Unable to Start the HPPM Service for Linux .............................................................................186
Unable to Uninstall Macromedia Flash Plug-in on Microsoft Windows Operating Systems ....186

 
 

Attached Device Did Not Shut Down Gracefully 

Action: Be sure the shutdown settings do not exceed the UPS runtime. 
 

Battery Test Complete Not Displayed 

Action: View the results of the battery test on the Logs and Reports screen. 
 

Battery Test Did Not Run 

Possible Cause: The UPS is On Battery. 

Action: The UPS must be in a certain state before the battery test runs. For more 
information, refer to the section, "Parameters Menu Option (on page 124)." 
 

Broadcast Messages Are Not Displaying 

Possible Cause:  

• The broadcast setup under HPPM is incorrect. 

• The Messenger service is not enabled. 

Action: 

• For broadcast messages from Linux to Windows®, the Netbios name of the 
recipient must be used. Also, refer to "Setting Up Broadcasts (on page 149)." 

• Enable the Messenger service. The messenger service is accessed from the 
Services option in the Administrative Tools section of the Control Panel. 

 



 Troubleshooting 177 
 

 

Cannot Access HPPM After Installation 

Possible Cause: 

• The Management Server software might not be running. 

• An HTTP port number other than the default (80) was selected during 
installation. 

• Other Web servers or Web-based applications are running on the same port. 

• You chose SSL during installation. 

• Clicking Exit from the system tray menu only removes the HPPM icon from 
the system tray. 

Action: 

• To start the Management Server: 

For Windows®, right-click the icon in the system tray, and select Start 
Service, or from the Start Menu, select Programs>HP Power 
Manager>HP Power Manager Status. 

For Linux, run /etc/rc.d/init.d/DevMan start. 

For HP-UX, run /sbin/init.d/DevMan start. 

• Be sure to include this port number when browsing to HPPM. For example, 
if you chose port 1234 during installation, enter the following in your 
browser for HPPM access: 

http://hostname:1234 

where hostname is either a machine name or an IP address. 

• Do one of the following: 

– Be sure that no other Web servers or Web-based applications are running 
on the same port. 

– Try using another port during installation or reconfiguration. 

• Be sure to use HTTPS instead of HTTP in your browser to access HPPM. 
For example, https://hostname:1234 would establish an SSL link to HPPM 
running on port 1234. 
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• Restart the system tray icon by selecting Programs>HP Power 
Manager>HP Power Manager Status from the Start Menu. Right-click the 
system tray icon, and select Stop Service form the context menu. 

 

DevManRA.nlm Does Not Load Correctly 

Possible Cause: Install is unable to retrieve the hostname. 

Action: Verify the host file and ensure no leading zeros are in the IP address (for 
example 172.025.240.230), which can cause failure to obtain the hostname. 
 

E-Mail Notifications Are Not Received from an HP-UX 
Management Server 

Action: Add the IP address and host name of the e-mail server to the host file of 
the computer running the HPPM Management Server software. 
 

Event Notification Messages Do Not Appear on 
Console Screen 

Action: If you are using SLES 9, upgrade the KDE or use a different desktop, 
such as GNOME. 
 

Input Frequency Shows Zero 

Symptom: During a battery test the input frequency shows zero, but the input 
frequency shows a regular line voltage. 

Possible Cause: When executing a battery test, the parameters might show 
incorrect information. 

Action: Verify the parameters after the battery test is complete. 
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Invalid IP Address 

Possible Cause: IP addresses are not checked for validity. 

Action: Verify that the IP address entered is valid. 
 

Linux Shows Garbage Characters and Cannot Install 
the Flash Player Utility 

Possible Cause: This is a function of the browser. 

Action: Save the Flash Player setup file to the local drive and run it from there. 
 

Low Battery Warning Is Displayed 

Action: Plug the UPS into an AC grounded outlet for at least 24 hours to charge 
the batteries, and then test the batteries. Replace the batteries if necessary. 
 

Management Server Shows No Device or UPS Not 
Connected 

Symptom: After changing the UPS hardware, the Management Server shows No 
Device or UPS Not Connected. 

Possible Cause: The Management Server cannot communicate with the UPS 
because of the change. 

Action: 

• Reconfigure the UPS with new settings: 

– For Windows, right-click the icon in the system tray, and select 
Configure. 

– For Linux, run /etc/rc.d/init.d/DevMan setup. 
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– For HP-UX, run /sbin/init.d/DevMan setup. 

• Verify the connection is the same as previously installed. 
 

Manual Load Dumped Alarm Not Working 

Symptom: For the R3000 XR, turning off the UPS from the front panel does not 
result in a "Manual Load Dumped" alarm. 

Possible Cause: The "Manual Load Dumped" alarm is not supported on this 
model.  

Action: No action is required. 
 

Network Attached UPS Not Discovered 

Action:  

1. Be sure the network cable is properly connected. 

2. Verify the password that is configured in the network option card installed in 
the UPS. The default password is MustB6. The password is case sensitive. 

3. Verify that the IP address entered is the same as the IP address configured in 
the card. 

4. Verify that the network settings are correct. 
 

No Power 

Action: Verify that the UPS is connected to a working outlet and that the UPS is 
powered up. 
 

No Shutdown Warning Messages on the NetWare 6 
System Console 

Action: View the Power Manager Remote Agent screen for broadcast messages. 
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On Battery Alarm 

Action: The UPS continues to run on battery power until the battery is 
completely discharged (or until utility power is restored), unless the shutdown 
parameters specify to turn off both the system and the UPS. 
 

On Boost Alarm 

Possible Cause: The input voltage is too low for the UPS. The UPS boosts the 
voltage up to acceptable limits.  

Action: For information on Boost mode, refer to the UPS documentation. 
 

On Buck Alarm 

Possible Cause: The input voltage is too high for the UPS. The UPS bucks the 
voltage down to acceptable limits. 

Action: For information on Buck mode, refer to the UPS documentation. 
 

Overload Alarm 

Possible Cause: The device load has exceeded the UPS power rating. 

Action: Verify all equipment is drawing within the rated requirements. If 
necessary, reduce the equipment connected to the UPS. The UPS might need to 
be reset. 
 

Receiving a Security Error 

Symptom: Security error: Domain Name mismatch message when trying to 
browse with SSL. 

Possible Cause: The IP address or server name has changed. 
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Action: Stop the service, delete the certificate file, and restart the service. 
 

Red Status Icon Displays 

Symptom: After adding a Remote Agent on the Attached Devices screen, a red 
status icon continues to display for that Remote Agent. 

Possible Cause:  

• The Remote Agent software might not be running. 

• The Remote Agent might not be configured to allow management from the 
address of the Management Server. 

Action: 

• Start the Remote Agent software: 

– For Windows, right-click the icon in the system tray, and select Start 
Service. 

– For Linux, run /etc/rc.d/init.d/DevMan start. 

– For HP-UX, run /sbin/init.d/DevMan start. 

– For Netware, load the agent from the directory to which it was installed, 
such as SYS:HPPM/DEVMANRA.NLM, using the forward slashes to 
separate directories. 

• Configure the Remote Agent to allow management by the Management 
Server: 

– For Windows, right-click the icon in the system tray, and select 
Configure, or select Programs>HP Power Manager>Configure HP 
Power Manager from the Start Menu. 

– For Linux, run /etc/rc.d/init.d/DevMan setup. 

– For HP-UX, run /sbin/init.DevMan setup. 

– For NetWare, uninstall and reinstall the Remote Agent according to the 
instructions in "Installing Components on NetWare Operating Systems 
(on page 104)." 
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Save Button Does Not Appear on Advanced Power 
Fail Settings Screen 

Action: Be sure that the screen resolution is not set above 1024 x 768. If 
necessary, reduce the resolution to 1027 x 768. 
 

Serial Attached UPS Not Discovered by a ProLiant 
DL145 Management Server 

Possible Cause: The serial port on the ProLiant DL145 has two functions. The 
serial port acts like a standard serial port and serves as an interface to the 
management processor within the server. The constant switching of the serial 
port between these two functions does not permit reliable serial communication 
between the Management Server and the UPS. 

Action: Connect the UPS to the server using a USB cable or a network cable. 
 

Servers Running Windows® Server 2003 Do Not 
Restart 

Symptom: Servers running Windows® Server 2003 do not restart upon power 
restoration following a power fail shutdown. 

Possible Cause: This is a known Windows® Server 2003 behavior on some 
servers. 

Action: Refer to the Microsoft® Knowledge Base article 819760. 
 

Shows Shutdown Events Succeeding Messages 

Symptom: HPPM shows shutdown events succeeded message when entering a 
valid or an invalid entry for delay without selecting the Shutdown checkbox. 

Possible Cause: Delay in application. 
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Action: Delay can be saved before the selecting the Shutdown checkbox. 
 

Silent Install Did Not Execute Successfully 

Action: 

• Verify the command line parameters are correct. 

• Verify the configuration .ini file is valid. 

• Verify the Setup.iss destination path is correct. 

• Refer to the InstallShield Knowledge Base article 101901 for the setup.log 
result code. 

 

Task Bar Menu Does Not Clear 

Symptom: The task bar menu does not clear when clicking off the menu onto the 
Windows® desktop. 

Possible Cause: This is a known Windows® behavior. 

Action: Start another application or open a new window, and the issue 
disappears. 
 

Unable to Browse into HPPM 

Possible Cause: The Mozilla default settings are incorrect. 

Action: Open the all.js file in the mozilla/defaults/pref folder, and change the 
lines as indicated in the section, "Mozilla Settings (on page 29)." 
 

Unable to Discover a UPS 

Action: 
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• Verify that the UPS is connected to the correct communications port (COM1, 
COM2, and so on). 

• Verify that no other software or processes are accessing the communications 
port to which the UPS is attached. 

• Verify that you are using the communications cable that came with the UPS. 

• Verify that resources for the selected communications port (such as I/O port 
or IRQ) are not shared with other devices. 

• Try a different communications port. 
 

Unable to Discover the HP UPS R6000 

Action:  

1. Verify that the baud rate for the serial com ports on the UPS R6000 are 
configured to at least 9600 baud. 

2. Verify that the correct serial cable is used to connect the UPS to the 
computer. 

 

Unable to Locate the .INI Files for a Silent Install 

Possible Cause: The DevManRA.ini and DevManBE.ini files are automatically 
created in the top-level program directory. 

Action: 

• For Windows®, if installed to the default location, the files are located at 
/Program Files/HP/Power Manager on the Management Server, and at 
/Program Files/HP/Power Manager Remote Agent on the Remote Agent. 

• For Linux, both files can be found at /usr/local/DevMan. 

• For HP-UX, both files can be found at /opt/DevMan. 
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Unable to Reboot the Machine 

Possible Cause: If the system hangs when the InstallShield wizard for the 
Remote Agent is left open and minimized during the attempted reboot. 

Action: Manually power off the machine. 
 

Unable to Start the HPPM Service for Linux 

Symptom: You cannot start the service for Linux, or the error message 
Segmentation fault /usr/local/DevMan displays. 

Possible Cause:  

• The server name and IP address are incorrect. 

• Files are missing 

Action: 

• Update the server name and IP address on /etc/hosts. 

• Install the file compat-libstdc++7.3-2.96.110.i386.rpm, which is required by 
the HPPM Linux package (PowerManager-4.0-10i586.rpm). 

 

Unable to Uninstall Macromedia Flash Plug-in on 
Microsoft Windows Operating Systems 

Action: Download the uninstaller provided on the Macromedia website 
(http://www.macromedia.com). 
 

http://www.macromedia.com/
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Alert Messages 

In this section 

HPPM Alert Messages................................................................................................................187
 
 

HPPM Alert Messages 

This software enables you to execute a command and send an e-mail, broadcast 
notification, and SNMP traps to specified recipients if a certain alert situation 
prevails. 

The following table lists all message texts and a description of each alarm. 
          

Alarm Text Description 

Battery Discharged • The battery is not fully charged. 

• The battery has been discharged to its maximum discharged state. 

• The UPS was on battery for long enough to exhaust the battery 
capacity and has shut down. 

Batteries Disconnected The UPS detects that at least one of the batteries is not connected. 
Backup power is either gone or considerably reduced. 

Battery Failure • The battery contactor/breaker is open. 

• The battery voltage has exceeded a predetermined limit. Operating 
with this alarm set can cause permanent battery or system damage. 

• A battery problem has been detected. 

• A battery test has been executed, and the battery failed the test. 

• The charger circuit has detected possible bad batteries or an open 
circuit in connections to the batteries. 

Battery Low The battery voltage level has dropped below the predetermined "low 
battery warning" level. 

Bypass Failure The bypass input voltage is not available for transfer. This condition might 
be caused by over or under voltage, over or under frequency, out of phase 
lock, or other reasons. 



188  HP Power Manager 4.0 User Guide 
 

 

Alarm Text Description 

Bypass ON Auto The UPS is on bypass, and the critical load does not have power 
protection. 

Bypass ON Manual A user has flipped a switch (for example, Maintenance Bypass) that 
bypasses the UPS.  

Check Breaker • The inverter output contactor/breaker is open. 

• The rectifier/charger input breaker is open. 

Electronics Module 
Failure 

For an "n+1" parallel system, one of the power modules has failed. 

EPO Initiated The UPS has shut down because of the activation of the remote EPO 
signal. 

Input Out of Range • Input (Utility) fault: Measured input voltage has exceeded the upper 
voltage limit specification for normal operation. 

• Input (Utility) fault: Measured input voltage is less than the lower 
voltage limit specification for normal operation. 

• Input (Utility) fault: Measured input frequency is outside the upper or 
lower frequency limit specification for normal operation. 

• Rectifier fault: Measured rectifier input current exceeds the upper 
current limit specification for normal operation. 

• The utility input power is not within predetermined limits. This is 
possibly caused by over voltage, under voltage, over frequency, under 
frequency, or over current. 

• The utility input is not present, and detected voltage is zero. 
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Alarm Text Description 

Internal Failure • An attempt to automatically recalibrate the UPS has failed. 

• Charger fault: The battery charger has failed. 

• DC Link fault: Measured DC link voltage has exceeded the upper 
voltage limit specification for normal operation. 

• At least one fan in the UPS has failed. 

• At least one fuse in the UPS has failed and must be replaced. 

• Inverter fault: Measured inverter output voltage has exceeded the 
upper voltage limit specification for normal operation. 

• Inverter fault: Measured inverter output voltage is less than the lower 
voltage limit specification for normal operation. 

• The inverter module has failed its power up self-test or its continuous 
self-test. 

• Inverter fault: The inverter has failed. 

• The inverter output has failed and cannot support the load. The 
reasons for this alarm are, for example, inverter over or under voltage, 
over or under frequency, distorted waveform, and output out-of 
window. 

• Inverter fault: The measured inverter output current exceeds the upper 
current limit specification for normal operation. 

• The inverter output voltage sensor has not been calibrated. 

• For a parallel system, this module has detected that the sync bus is not 
active. 

• A test of the device EEPROM has detected a checksum failure. The 
device either has not been programmed or contains suspicious data. 

• A test of the device ROM has detected a checksum or CRC error. The 
device's operating code is suspicious and should be replaced or 
reflashed. 

• In a multi-module system or internally to a UPS with multiple 
controllers, the firmware versions in place are not compatible with 
each other. 

Manual Load Dumped The load power is off. This alarm is used to record the date and time of an 
EPO event. 

On Battery The UPS is using the battery to power the load. 

On Boost The UPS detected a low input condition and is increasing input voltage to 
a nominal level. 
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Alarm Text Description 

On Buck The UPS detected a high input condition and is reducing input voltage to a 
nominal level. 

Output Out of Range • Measured output voltage has exceeded the upper voltage limit 
specification for normal operation. 

• Measured output voltage is less than the lower voltage limit 
specification for normal operation. 

• Measured output frequency is outside the upper or lower frequency 
limit specification for normal operation. 

Overload • Overload alarms are sent based on the individual UPS model overload 
protection specifications that are available in the UPS documentation.  

• The load on the UPS output phase exceeds its rated current or power 
by more than a small margin over 100%. The inverter can only sustain 
this overload for a short time without shutting down because of 
overheating. 

Remote Agent Not 
Connected 

A Remote Agent is not communicating with the Management Server to 
which it is associated. 

Shutdown Imminent The UPS has entered a state where it might abruptly shut down without 
further notice. It might continue to operate indefinitely, even with this alarm 
being issued. 

Shutdown Pending A condition in the UPS will lead to the loss of power to the loads in less 
than the Low Battery Time, unless the condition is cleared or removed. 

Site Wiring Fault There is a fault in the input wiring, other than Phase Rotation (for example, 
Ground/Neutral reversed). 

Temperature Out of 
Range 

• An ambient temperature probe has detected that the temperature is 
above its upper limit. 

• A heatsink at an unspecified location in the UPS has failed. 

• An input or output transformer used by the UPS has exceeded its 
upper temperature limit. 

UPS Not Connected The Management Server is unable to communicate with the UPS. 

UPS Started On Battery The UPS has been started on battery when AC input power is not present. 
This alarm is used to record the date and time of this event. 
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Using HPPM with Insight Manager 7 SP2 

In this section 

Insight Manager 7 SP2 Overview...............................................................................................191
Configuring Insight Manager 7 SP2...........................................................................................193
Configuring HPPM with Insight Manager 7 SP2 .......................................................................193

 
 

Insight Manager 7 SP2 Overview 

HPPM can be configured to send alert traps to Insight Manager 7 SP2, as well as 
other SNMP management applications. To send event alert traps to Insight 
Manager 7 SP2:  

1. Configure Insight Manager 7 SP2 to receive a trap from HPPM. 

2. Configure the software to send the appropriate event alert traps. 

If the software is installed using the default HTTP on port 80, a link to the 
software appears on the device home page in Insight Manager 7 SP2 for the 
computer with HPPM. 

If the defaults are not used, a new entry can be made to the 
additionalwsdisc.props file, located in the CONFIG directory in the Insight 
Manager 7 SP2 install directory, to correctly discover and identify HPPM 
running on any computer. Beginning with the SP2 release, Insight Manager 7 
SP2 is installed in the C:\Program Files\HP\Insight Manager 7 SP2 directory by 
default. For more information on editing the additionalwsdisc.props file, refer to 
the additionalwsdisc.txt file located in the same directory. 

Example B-1:  ADDITIONALWSDISC.PROPS file with HPPM Entry 

# ----------------------------------------------------
----------------------- 

# Additional Web Server Discovery Properties 

# 
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# ----------------------------------------------------
----------------------- 

# NOTE: See "additionalWsDisc_README.txt" for a 
description of entries in  

# this file and how to add or remove additional web 
server ports used for  

# discovery and identification. 

# ----------------------------------------------------
----------------------- 

# 

# ----------------------------------------------------
----------------------- 

#  The following are actual web server ports enabled 
by default. 

#  To remove them from the discovery process, comment 
out the line with a '#' 

#  or remove it. You will need to restart the Insight 
Manager 7 service for  

#  the changes to take effect. In addition you will 
need to run the Device  

#  Identification task to find any new ports that were 
defined. 

# ----------------------------------------------------
----------------------- 

411=Director Agent, ,true,false, ,http 

3201=Compaq TaskSmart, ,true,false, ,https 
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8008=Default Home Page, ,true,false, ,http 

1311=Server Administrator, ,true,false, ,https 

1234=HP Power Manager, ,true,false, ,https 

The last entry allows Insight Manager 7 SP2 to detect HPPM installations that 
are running on port 1234 and using HTTPS (Secure Socket Layer protocol). 
 

Configuring Insight Manager 7 SP2 

Verify that the HPPM MIB (CPQRPM.MIB) is registered in Insight Manager 7: 

1. Upload the HPPM MIB. The HPPM MIB (CPQRPM.MIB) can be found on 
the HP Rack and Power Management Pack CD and in the install folder of the 
HPPM Management Server. 

2. Register the HPPM MIB. 

NOTE:  For additional information on uploading and registering and MIB 
in Insight Manager 7 SP2, refer to the HP Insight Manager Technical 
Reference Guide located on the HP Management CD. 

 

Configuring HPPM with Insight Manager 7 SP2 

To configure the software to send traps to Insight Manager 7 SP2: 

1. Add the Insight Manager 7 SP2 server as an SNMP Trap recipient. 

2. Configure the software to send alert notifications to Insight Manager 7 SP2 
as SNMP traps. 
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Using HPPM with HP Systems Insight 
Manager 

In this section 
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Launching HPPM from the HP SIM Tools Menu ......................................................................197

 
 

HP Systems Insight Manager Overview 

HPPM can plug into HP SIM. As a plug-in to HP SIM, you can: 

• Discover HPPM Management Servers. As part of the HP SIM discovery 
process, HP SIM can detect an installed Management Server. It can be 
launched from the HP SIM Servers Links tab. 

• Receive SNMP traps from the HPPM Management Server. This software can 
send event-based traps to HP SIM that include a URL in the trap. This 
functionality enables administrators to easily launch HPPM in context. For 
example, if a UPS goes on battery power, the Management Server can send a 
trap to HP SIM with an attached hyperlink that routes users directly to the 
Device Overview page for that UPS. 

• Conveniently launch HPPM from within HP SIM. 

– Tools menu—Users can add a link to the Home page on the HP SIM 
Tools menu using a tools definition file. 

– Servers Links tab—The Home page can be launched from the HP SIM 
Servers Links tab. 

– Event-based trap—A URL is included in each trap to link directly from 
HP SIM to the Device Overview page for the specific device for which 
the trap was sent. 
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Discovering HP Power Manager 

HP SIM automatically detects Management Servers as part of the device 
discovery process. If detected, an HPPM hyperlink is included on the HP SIM 
Links page for the system with the Management Server component installed. 
HPPM services should be installed and running before attempting discovery 
through HP SIM. If HPPM services are not running, it will not appear on the HP 
SIM Links tab. 
 

Receiving SNMP Traps 

Before HP SIM can receive traps, the correct MIB file (CPQRPM.MIB) must be 
compiled into HP SIM. By default, CPQRPM.MIB version 1.6 is registered. 
Unregister the version 1.6 MIB and register the version 1.7 MIB located in the 
MIB folder of HP Rack and Power Management Pack CD. 

To verify, unregister, and register an MIB: 

1. From the HP\Systems Insight Manager\mibs folder, note the version of 
CPQRPM.MIB.  

2. If the MIB is not version 1.7, run MXMIB -D CPQRPM.MIB from the 
HP\Systems Insight Manager folder to unregister the MIB. 

3. Verify that the MIB is successfully unregistered by entering HP\Systems 
Insight Manager>mxmib at the command line. Verify that the old MIB 
is not listed. 

4. Delete and replace or copy over CPQRPM.MIB with the correct version. 

5. From the HP\Systems Insight Manager\mibs folder, run mcompile 
cpqrpm.mib from the command line to compile the new MIB. A new file 
named CPQRPM.CFG is created. 

6. Register the new MIB by entering mxmib -a cpqrpm.cfg from the 
HP\Systems Insight Manager\mibs command line. 

7. Verify that the new MIB is registered by entering HP\Systems Insight 
Manager\mibs>mxmib at the command line. 
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NOTE:  For more information on uploading and registering a MIB in HP 
SIM, refer to the HP Systems Insight Manager Technical Reference 
Guide located on the HP Management CD. 

 

Launching HPPM from the HP SIM Tools Menu 

A launch link for each instance of HPPM can be added to the HP SIM Tools 
menu. Configure the links using a tool definition file for each instance of the 
software. 

Using the command line interface, perform the following steps to add a tool 
definition file to HP SIM: 

1. Create or copy and edit the tool definition file, and save it with an .xml file 
name extension. For example, HPPowerManager.xml.  

A sample tool definition file named HPPM.XML is landed in the root 
directory. 

IMPORTANT:  The only information that should be edited is shown in 
bold text. 

Example: 
<?xml version="1.0" encoding="UTF-8" ?>  
<tool-list> 

<web-launch-tool name="HPPM" max-targets="1" 
revision="4.0"> 

<category>Local Tools</category>  
<description>HP Power Manager</description>  
<execute-as-user>root</execute-as-user>  
<toolbox-enabled value="true" />  
<web-block accepts-targets="false"> 
  <main-url>http://172.25.234.206</main-url>  
</web-block> 
<attribute name="menu-path">Tools|Integrated 
Consoles</attribute>  
<attribute name="i18n-
attrs">TOOL,HPPowerManager</attribute>  
<attribute name="target-frame">RPMFrame</attribute>  

</web-launch-tool> 
------ 

<web-launch-tool name="HPPM1" max-targets="1" 
revision="4.0"> 
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<category>Local Tools</category>  
<description>HP Power Manager</description>  
<execute-as-user>root</execute-as-user>  
<toolbox-enabled value="true" />  
<web-block accepts-targets="false"> 
  <main-url>http://172.25.234.207</main-url>  
</web-block> 
<attribute name="menu-path">Tools|Integrated 
Consoles</attribute>  
<attribute name="i18n-
attrs">TOOL,HPPowerManager</attribute>  
<attribute name="target-frame">RPMFrame</attribute>  

</web-launch-tool> 
</tool-list> 

Where: 

– HPPM and HPPM1 are the names of each configuration that appears on 
the Tools menu in HP SIM. The name should be descriptive enough so 
that it reflects what it is linked to. For example, "HP Rack and Power 
Management server (Houston)." Because several instances of the software 
can be added to this menu, HP recommends that this name be unique for 
every instance.  

– HP Power Manager is the description name of the application. This 
name appears only in the list of tool definition files and assists the user in 
determining which tool definition is for what application. 

– http://172.25.234.206 and http://172.25.234.207 are the IP addresses of 
the Management Servers. 

2. Copy the tool definition file you created in step 1 to the HPSIM program 
folder. The default folder is HP\Systems Insight Manager. 

3. If you are running a Japanese operating system, copy the provided properties 
file HPPowerManager_ja.properties to the HPSIM program folder. 
The default folder is HP/Systems Insight Manager. 

4. From the HPSIM program folder, run setnimbusenv. 

5. From the HPSIM program folder, run mxtool -a -f <filename.xml>, 
where <filename.xml> is the name you chose in step 1. For example: 
mxtool -a -f HPPowerManager.xml. 

6. Log out of the current browser session, stop and start the HP Systems Insight 
Manager services, and then log back in before using the new link. 
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7. Launch HPPM by selecting Tools>Integrated Consoles>HPPM. 

NOTE:  After a tool is added, you can edit the tool by modifying the XML 
tool definition file and committing the changes using mxtool -m from 
the command line. For a complete description of mxtool arguments, 
refer to hpwebadmin\webapps\mxhelp\mxportal\man\mxtool.1m.html in 
the HPSIM program folder. 
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HP Power Manager Security Considerations 

In this section 

Security Considerations Overview .............................................................................................201
 
 

Security Considerations Overview 

HP Power Manager implements strict security for two important reasons: 

• HP Power Manager has managed devices that have the potential to perform 
operations that are sensitive and destructive. 

• The application has browser accessibility. 

To better ensure the security of HP Power Manager and the devices it manages, 
consider the following topics in accordance with your organization's security 
policies and the environment in which HP Power Manager will operate. 

• Access to HP Power Manager requires an account in HP Power Manager. 
Logging in requires the use of a user name and password, which should be 
kept properly secured.  

• Each account in HP Power Manager can be given different access levels, 
providing different capabilities. Ensure that the appropriate access level is 
granted to users of HP Power Manager. 

• Browsing to HP Power Manager can be done using SSL, which encrypts the 
data between the browser and Management Server. The level of encryption 
supported by HP Power Manager is 128-bit. SSL also provides 
authentication of the Management Server by means of its digital certificate. 
Securely importing this certificate must be done to ensure the identification 
of the Management Server. 

• The UPS network adapter requires a password, which should be changed and 
kept properly secured. The default adapter password is MustB6. 
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IMPORTANT:  The password you enter must match the password 
configured in the UPS network adapter. If you want to change the 
password, first configure the adapter with the new password, and then 
enter the new password during the Management Server configuration 
process. For more information about configuring the adapter, refer to 
the HP Power Products CD that came with the adapter. 
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Configuring HP Power Manager with an 
Enabled Firewall 

In this section 

Configuring HP Power Manager with an Enabled Firewall .......................................................203
 
 

Configuring HP Power Manager with an Enabled 
Firewall 

Enabled firewalls block most communication though unused IP ports. This 
prevents the Management Server and Remote Agents from using port 3573 to 
communicate. The following Windows firewall settings are necessary for the 
proper operation of HP Power Manager through port 3573. 

1. Click Start>Settings>Control Panel. 

2. Open Network Connections. 

3. Click Properties. 

4. Click the Advanced tab. 

5. Select the Internet Connections Firewall checkbox. 
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The Windows Firewall screen appears. 

 

6. Click the Exception tab, and then click Add Port.  
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The Add a Port screen appears 

 

7. Enter the name for the new port in the Name: field. 

8. Enter 3573 in the Port number: field. 

9. Select the TCP radio button. 
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10. (optional) Click Change scope to add security settings to the port, and then 
click OK. 

 

11. Click OK to finish adding the port.  
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The Windows Firewall screen appears and displays the newly added port. 
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Acronyms and abbreviations 

CRC 

cyclic redundant checks 
 

DNS 

domain name system 
 

EEPROM 

electrical erasable programmable read only memory 
 

EPO 

emergency power off 
 

EULA 

end user license agreement 
 

GUI 

graphical user interface 
 

HPPM 

Hewlett-Packard Power Manager 
 

HTTPS 

hyper text transfer protocol secure sockets 
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I/O 

input/output 
 

IP 

Internet Protocol 
 

IRQ 

interrupt request 
 

MIB 

management information base 
 

RAM 

random access memory 
 

SAM 

system administration manager 
 

SIM 

Systems Insight Manager 
 

SNMP 

Simple Network Management Protocol 
 

SSL 

Secure Sockets Layer 
 

TCP 

Transmission Control Protocol 
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UPS 

uninterruptible power system 
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